
Build: 16 bit Agent:
NoFree:    No (Free Agent only topics)
YesMail:    Yes (Receive email topics)
YesFolders:    Yes (All aspects of folders)
YesSpelling:    Yes (Spell check topics)
YesSorting:    Yes (Sorting topics)
NoBit32:    No (Features only available in the 32bit version)



 Free Agent Contents
Free Agent is a powerful and easy-to-use Usenet newsgroup reader.    It allows you to browse 
newsgroups both online and offline.    Before you start using Free Agent, please take a quick look at 
Getting Started.

For more information about using Free Agent, see How to Use Agent.

For full email support, a spell checker, and more advanced newsreading features, try Forté's commercial 
package, Agent.    See Agent Features for a more detailed description of this product.    To purchase your 
own copy of Agent, see Ordering Agent.

If you have any comments, questions, or problems with Free Agent, see How to Receive Technical 
Support.

To help familiarize yourself with Free Agent's Browser window, click on the various components of the 
picture below.

Copyrights



Agent Contents
Agent is a powerful and easy-to-use Usenet newsgroup reader.    It allows you to browse newsgroups 
both online and offline.    Before you start using Agent, please take a quick look at Getting Started.

For more information about using Agent, see How to Use Agent.

If you'd like to purchase a copy of Agent for a friend, see Ordering Agent.

If you have any comments, questions, or problems with Agent, see How to Receive Technical Support.

To help familiarize yourself with Agent's Browser window, click on the various components of the picture 
below.

Copyrights



Add Signature dialog box (Signatures dialog box, Options menu)
Use this dialog box to enter the name of a new signature.

Name
Enter the name of the new signature



Use Information From Another Program dialog box
Use this dialog box to select the program from which Agent will acquire its basic setup information.

Program
Select the program from which you wish to get the initialization information.

Copy program's list of newsgroups
Check this box if you want Agent to use the selected program's newsgroup list to fill in its own list.    If 
you have subscribed to newsgroups in the selected program, you will be subscribed to those groups 
in Agent as well.
Note: If the newsgroup list in the other program is out of date, either uncheck this box or choose 
Refresh Group List from the Online menu at a later time.



Use Information From dialog box
Use this dialog box to enter the location of the program from which Agent will acquire its basic setup 
information.

Enter the name of the directory...
Type in the other program's complete path, including drive.    For example, C:\TRUMPET.



Window Layout dialog box (Options menu)
Use this dialog box to select the layout of the panes in the current window.    You can choose how the 
panes should be arranged and what the contents of each pane should be.

Layout of Panes
These buttons show all of the available pane layouts.    Click on a button to choose a layout.

Contents of Panes
For the layout you have selected above, these buttons show all of the ways that you can organize the 
Groups/Folders pane, Message List pane, and Message pane.    The box with black text represents 
the Groups/Folders pane.    Red text represents the Message List pane.    The Message pane has 
blue text.    Click on a button to choose an organization.

After you have chosen a layout and pressed OK, the window will update to reflect your selection.    If you 
desire, resize the panes by dragging the border between the panes.

TIP:    To show only one pane at a time, select Zoom Window from the Navigate menu or press Z.

If you would like to have a particular layout be the one used when you start Agent or open a new Browser 
window, choose Save As Default Window Layout from the Options menu.    This command saves the pane
layout, pane sizing, and whether or not a pane is zoomed.



Preferences dialog box (Options menu)
Attachments Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how binary 
attachments sent by you are formatted.    For more information on sending attachments, see How to Send
a Binary Attachment.

Send attachment as multiple messages
Select this option to split long attachments into multiple messages.    The size of each attachment is 
dictated by the number you enter into the Lines per Messages box.

Send attachment as a single message
Select this option to include the entire attachment in one message, no matter how long the 
attachment is.

Send text as preface message
Select this option to send an additional message ahead of the attachment message(s).    This is useful
because it allows people to read a description of the attachment before downloading it.

Send text in first message
Select this option to include the description of the attachment in the attachment's first message.

Do not send any text
When this option is selected, Agent will only send the attachment.    Any other text or description you 
enter into the Compose window will be ignored.



Preferences dialog box (Options menu)
Colors Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls the color of text in 
Agent.

Normal Lines
Choose the color for groups, folders, and read message headers.

Unread Messages
Choose the color for unread message headers.

Highlighted Unread Messages
Choose the color for unread message headers when they are selected.    This is usually the inverse of
the Unread Messages color.

Normal Text
Choose the color for body text.

Quoted Text
Choose the color for response text within a message's body.



Preferences dialog box (Options menu)
Confirmations Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls the confirmation 
messages Agent displays.    These messages warn you when you are about to perform an irreversible 
action.

Delete Groups or Folders
Check this box and Agent will display a confirmation message when you manually delete a group or 
folder.

Delete messages or message bodies
Check this box and Agent will display a confirmation message when you manually delete a message 
or its body.

Delete outbox messages
Check this box and Agent will display a confirmation message when you manually delete a message 
from the Outbox window.

Close message composition window
Check this box and Agent will display a confirmation message when you close a posting or email 
window without sending the message first.

Stop online tasks
Check this box and Agent will display a confirmation message when you cancel an online operation.

Close program while online tasks are running
Check this box and Agent will display a confirmation message when you exit Agent while it is 
communicating with the news server.

Mark all messages read or unread
Check this box and Agent will display a confirmation message before marking all the messages in a 
group or folder read or unread.

Launch executable binary attachments
Check this box and Agent will display a confirmation message before running an executable (*.exe 
file) detached from a message.

Default action in confirm dialogs is YES
Check this box to make "Yes" the default button on all confirmation dialog boxes.    The default button 
is the one activated when you press the Enter key.



Preferences dialog box (Options menu)
Display Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how Agent's 
Browser window appears and behaves.

Show Toolbar
Check this box to display the Agent toolbar directly below the menubar.

Show Status Bar
Check this box to display the Agent status bar at the bottom of the window.

Tab Spacing
Enter the length of tab stops, in characters.

Quoted Text
Enter the characters that commonly appear in follow-up messages signifying that text on the same 
line is quoted from the original message.    Agent displays this text in the color defined by the Quoted 
Text setting on this dialog box's Colors tab.

Scroll Margins
Enter the number of rows you want to remain visible above or below the highlighted row when 
scrolling up or down in the Message and Body panes.

Follow-Up Indentation
Enter the amount of space, in characters, that follow-up messages should be indented from their 
parent in the Message List pane.

Maximum Follow-Up Level
Enter maximum number of response levels (responses to responses) that you want displayed in the 
Message List pane.    Any responses deeper than this appear at the most indented level.

Date sorts descending
Check this box and Agent will display the newest messages at the top of the Message pane when it is
sorted by date.    When this box is unchecked, the newest message appear at the bottom of the pane. 
Note: You must resort the Message pane for this change to take effect.

Size sorts descending
Check this box and Agent will display the largest messages at the top of the Message pane when it is 
sorted by size.    When this box is unchecked, the largest message appear at the bottom of the pane.   
Note: You must resort the Message pane for this change to take effect.

Show author's full email address
Check this box to display email addresses and full names in the Author column.    When this box is 
unchecked, only full names are displayed.



Preferences dialog box (Options menu)
Navigation Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how Agent behaves 
when you are navigating within a Browser window.

Skipping to the next unread message...
Check this box and Agent will keep your focus in the same pane when you skip between messages in
different groups or folders.

Marking or ignoring...
Check this box and Agent will automatically skip to the next unread message after you mark a Usenet
message for retrieval or select a thread to be ignored.

Watching an unread message...
Check this box and Agent will automatically skip to the next unread message after you select Watch 
Thread (or press W) when an unread Usenet message is highlighted.

Skipping to the next unread group...
Check this box to have Agent automatically mark all the messages in the current group or folder 
"read" when you choose Skip to Next Unread Group.

Show Threads Initially Collapsed
Check this box to initially hide all responses in the Message List pane.

Automatically expand threads containing new messages
Check this box to have Agent automatically expand a thread when skipping to an unread message 
within a thread.    Agent expands the thread only if you had previously retrieved and read the first 
message in the thread.

Start a new thread...
Check this box to create a new thread when a follow-up Usenet message's subject is different than 
the main message's subject.    When unchecked, Agent attaches follow-up messages to the original 
even when the subject of the thread changes.

Enable threading by subject
Check this box to have Agent include messages with the same subject under the same thread, even if
the follow-up message doesn't contain a valid reference to the original.    People frequently mispost 
responses and this helps match follow-ups with the message to which they are responses.
Checking this box will also cause Agent to thread your email messages.

Double-clicking a message launches its binary attachment
Check this box and double-clicking on any message containing an attachment you've saved will run 
the program associated with the attachment's file type.    For more information, see How to Configure 
a GIF or JPG Viewer to Work with Agent.

See Also:
Navigating in Agent
Watching and Ignoring Threads



Preferences dialog box (Options menu)
Posting Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how messages that 
you send are formatted.

Line length
Enter the maximum number of characters that can appear on a single line.    Agent automatically word
wraps any lines longer than this.

Validate email address
When checked, Agent validates all email address fields (To:, Cc:, etc.) before sending 
messages.    Uncheck this box if you need to enter non-standard addresses.    Note: Agent
does not verify that the email address exists.    It simply checks the format to make sure 
it is a valid Internet email address.

Include original text
Check this box to include a copy of the original text in follow-up Usenet messages and email replies.

Quote original text in forwarded email
Check this box to insert the quote prefix (defined below) in front of each line of a message's text when
forwarding it via email.

Prefix for quoted lines
For follow-up and reply messages, enter the character(s) that signify that the text on the same line is 
quoted from the original message.

Follow-Up Usenet Msg
Enter the text to appear just above quoted lines when following-up to a Usenet message with another 
Usenet message.

Reply to Usenet Msg
Enter the text to appear just above quoted lines when replying to a Usenet message with an email 
message.

Forward Usenet Msg
Enter the text to appear just above quoted lines when forwarding a Usenet message to someone via 
email.

Reply to Email
Enter the text to appear just above quoted lines when replying to an email message with another 
email message.

Forward Email
Enter the text to appear just above quoted lines when forwarding an email message to someone via 
email.

For more information, see Composing an Introduction String.



Composing an Introduction String
When you reply to a message, it's common practice on the Internet to include some of the text from the 
original message in the reply.    It is also common practice to precede the original text with a line such as 
"Jessye Lynn Sidell wrote:"    You define this introduction string on the Posting tab of the Preferences 
dialog box.

The following table describes the different fields you can include in introduction strings.    When you 
include a field in an introduction string, Agent automatically replaces that field with its value from the 
original message.    To include a field in a string, enclose it within percent signs (e.g., %From%).    Note: To 
include the percent sign in the string, enter two of them next to each other (e.g., %%).
Field Description
Date The date the message was sent.
Reply-To Where the author wanted replies sent.
From The email address of the person who posted the message.
Sender The sender of the message.    Note: This may be a different person than the one in the 

From field if the sender wasn't the one who actually posted the message.
Full-Name The full name of the author, extracted from the From field.
Subject The brief description of the message.
Message-Id The message's unique message ID.
Newsgroups The newsgroup to which this message was posted.    If the message was posted to more

than one group, the current group is used.
Followup-To The newsgroups where the sender of the message wants follow-up messages posted.
Expires The date the message is scheduled to expire.
References For follow-up messages, the message IDs of the messages to which this message 

refers.
Organization The author's organization.
Keywords Optional keywords included by the author to help categorize the message.
Summary A summary description of the message.
Lines The number of lines in the message.

You may also use the following to represent special characters:

Character Description
\n The newline character.
\t A tab.
\\ The backslash character itself.



Preferences dialog box (Options menu)
Online Operation Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls Agent's behavior 
while online.

Use Offline Defaults
Press this button if you want to use Agent as an offline news and mail reader.    This button optimally 
configures the remaining controls in this dialog box for offline use.    For more information, see How to 
Use Agent as an Offline Newsreader.

Use Online Defaults
Press this button if you want to use Agent as an online newsreader. This button optimally configures 
the remaining controls in this dialog box for online use.    For more information, see How to Use Agent 
as an Online Newsreader.

Times to retry when server refuses connection
Enter the number of times Agent should attempt to reconnect to the news server when it refuses a 
connection.    This normally happens when the news server is busy.

Pause between retries
Enter the number of seconds between each reconnection attempt.

Close winsock (hang up) between retries
Check this box to have Agent hang up the modem between reconnection attempts.

Go offline automatically after...
Enter the number of seconds of inactivity that Agent waits before automatically disconnecting from 
your news server.    If you uncheck this box, Agent will not disconnect from your news server until you 
close the program or uncheck Online from the Online menu.
If you intend to read Usenet messages online, you might want Agent to go offline after a few minutes 
of inactivity.    This gives you time to read messages, but doesn't leave Agent online too long.    If you 
intend to read messages offline, you probably want Agent to go offline immediately (0 seconds of 
inactivity).

Send keep-alive messages every...
When this box is checked, Agent sends a command to your news server periodically in order to 
maintain the connection to the server.    This option is useful if your computer is connected to the 
server via a dial-up channel that automatically disconnects after a period of inactivity. 
Enter the frequency of keep-alive messages sent from Agent to your news server.    Uncheck this box 
and Agent won't send any keep-alive messages.

Enable priority message retrieval
When this box is checked, Agent opens a second channel to the news server when you attempt to 
retrieve the body of a message while Agent is already busy performing other online operations.    This 
makes it possible for you to begin reading new messages in one group while retrieving headers in 
another. 

Viewing Unretrieved Messages When Offline
Select the action you want Agent to perform when you are offline and attempt to view a Usenet 
message for which you do not have the body.    This setting affects double-clicking and pressing Enter
on messages, as well as the View Next Unread Message and View Next Unread Message in Thread 
actions on the Navigate menu.

See Also:
Online Menu Commands Explained



Preferences dialog box (Options menu)
System Profile Tab
Use this dialog box to define settings that affect how Agent works.    This tab defines information that is 
required to use Agent.

News Server
Enter the name of your news (NNTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Email Server
Enter the name of your email (SMTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Time Zone
Select the time zone you are located in.    Agent uses this setting to convert the times of messages to 
your own local time.    Also, when you post a message, Agent includes your time zone in the date.

Automatically adjust for Daylight Saving Time
Check this box if you live in a locality that observes Daylight Saving Time between April and October.  
During these months, Agent automatically adjusts your time zone to compensate for the time 
difference.



Preferences dialog box (Options menu)
User Profile Tab
Use this dialog box to define settings that affect how Agent works.    This tab defines information about 
you.

Email Address
Enter your email address.    When you send a message, this address appears in the "From" field.    
For example: lance.boehm@forteinc.com.

Full Name
(Optional) Enter your full name.    This name is included with your email address in messages that you
send.    It is helpful to include your full name if your email address does not contain your name.    Also, 
some programs, such as Agent, can display an author's full name rather than his/her email address.

Organization
(Optional) Enter the name of the organization to which you belong.    This name is sent in the 
"Organization" field of Usenet messages you post.    It is not included in your email messages.

Reply To
(Optional) Enter an email address here if you want people to send replies to an address that is 
different than your Email Address listed above.    For example, you may use your business address as
your Email Address, but would prefer that replies be sent to a personal email address.

Note:    Changing the Email Address, Full Name, Organization, or Reply To value here also changes the 
corresponding field on the Posting tab of the Default Properties for All Groups dialog box.

Server requires authorization login
Check this box if your news server requires a special user name and/or password to login.    When 
checked, Agent will automatically fill in your user name when requested by the news server.

User Name
Enter the user name required by your news server for logging in.

Remember password between sessions
Check this box if your news server requires a special password to login and you want Agent to 
automatically enter that password for you.

Password
Enter the password required by your news server for logging in.    For security, your password 
appears as asterisks (*) and is stored in an encrypted format in AGENT.INI.

Note: You must take Agent offline and then back online for changes to the user name or password to take 
effect.

Information about your incoming email server is defined on the System Profile tab of the Inbound Email 
dialog box.



Properties for Selected Groups dialog box (Group menu)
Marking Read Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab controls when Agent marks Usenet messages read.    Usually, you'll want to mark all existing 
messages read each time you retrieve new messages so that only the new ones are left unread. 

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

New message headers
Check this box to mark all existing Usenet messages read each time you retrieve new message 
headers for this group.

Marked message bodies
Check this box to mark all existing Usenet messages in this group read each time you retrieve 
marked message bodies for this group.    All the new messages Agent retrieves will be marked unread
so that you can easily find them.

See Also:
Marking Messages Read



Default Properties for All Groups dialog box (Group menu)
Marking Read Tab
Use this dialog box to define your default group settings.    This tab controls when Agent marks messages 
read.

This tab controls when Agent marks Usenet messages read.    Usually, you'll want to mark all existing 
messages read each time you retrieve new messages so that only the new ones are left unread. 

New message headers
Check this box to mark all existing Usenet messages read each time you retrieve new message 
headers for this group.

Marked message bodies
Check this box to mark all existing Usenet messages in this group read each time you retrieve 
marked message bodies for this group.    All the new messages Agent retrieves will be marked unread
so that you can easily find them.

See Also:
Marking Messages Read



Properties for Selected Groups dialog box (Group menu)
Posting Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab controls how postings to this group and email replies from this group are handled.    Note: All of 
these settings can be overriden for a particlular message.    See the Compose Usenet Message window 
and the Compose Email Message window for details.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.    Note: Checking this box only overrides the "Copy follow-up 
messages to author via email," "Signature," and "Spell Check Language" settings.    Each field in the 
"Fields" list must be overridden independently (see below for details).

Copy follow-up messages to author via email
When checked, Agent will send a copy of follow-up messages you post to the author of the message 
to which you are responding.    You can easily override this behavior for individual follow-ups by 
removing the author's name from the Email To field on the Compose Usenet Message window.

Signature
Select a signature to use for posting to this group or email replies from this group.

Spell Check Language
(Not available in Free Agent) Select the language dictionary to use when spell checking posting to this
group or email replies from this group.    For more information, see About Agent's Dictionaries.

File sent messages in folder
Select the folder in which to file messages you send from this group.    Choose "[Leave in Outbox]" to 
save all sent messages in your Outbox or choose "[Delete]" to have Agent delete your messages after
sending them.

Fields
This list contains all the Usenet message fields (and some email ones as well) for which you can set 
default values.    See Message Fields for a description of each field.    Setting a default value for these 
fields saves you time when creating messages because you don't have to reenter the common 
information each time.    You can even default the Newsgroups field to automatically cross-
post messages to several groups.
To change a particular field's default value:
1. Highlight the desired field
2. Check the "Override default value for field" box
3. Enter the new value in the "Value for <Field>" control.

Override default value for field
Check this box to use the default field value defined on this tab instead of the one defined in the 
Default Properties for All Groups dialog box.

Value for <Field>
Enter the default value for the field selected in the Fields list.    You must check the "Override default 
value for field" box before you can enter a value here.

See Also:
Compose Usenet Message window
Compose Email Message window
How to Post Usenet Messages
How to Send Email



Default Properties for All Groups dialog box (Group menu)
Posting Tab
Use this dialog box to define your default group settings.    This tab controls how postings are handled.    
Note: All of these settings can be overriden for a particlular message.    See the Compose Usenet 
Message window and the Compose Email Message window for details.

Copy follow-up messages to author via email
When checked, Agent will send a copy of follow-up messages you post to the author of the message 
to which you are responding.    You can easily override this behavior for individual follow-ups by 
removing the author's name from the Email To field on the Compose Usenet Message window.

Signature
Select a default signature for all your postings and email.    Note: Changing this setting here also 
changes the Default Signature defined in the Signatures dialog box.

Spell Check Language
(Not available in Free Agent) Select a default language dictionary for all your postings and email.    
Note: Changing this setting here also changes the Default Language defined on the Spelling tab of 
the Preferences dialog box.    For more information, see About Agent's Dictionaries.

File sent messages in folder
Select the folder in which to file messages you send.    Choose "[Leave in Outbox]" to save all sent 
messages in your Outbox or choose "[Delete]" to have Agent delete your messages after sending 
them.

File replies in same folder as original message
When replying or following up to a message in a folder, checking this box tells Agent to save your new
message in that folder instead of the folder specified above.

Fields
This list contains all the Usenet message fields (and some email ones as well) for which you can set 
default values.    See Message Fields for a description of each field.    Setting a default value for these 
fields saves you time when creating messages because you don't have to reenter the common 
information each time.    Note: The global defaults for the From, Organization, and Reply-To 
fields also appear on the User Profile tab of the Preferences dialog box.    Changing these 
fields here also changes them in that dialog box (and vice versa).
To change a particular field's default value:
1. Highlight the desired field
2. Check the "Override default value for field" box
3. Enter the new value in the "Value for <Field>" control.

Value for <Field>
Enter the default value for the field selected in the Fields list.

See Also:
Compose Usenet Message window
Compose Email Message window
How to Post Usenet Messages
How to Send Email



Properties for Selected Groups dialog box (Group menu)
What to Purge Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab controls which Usenet messages Agent automatically purges (deletes).    To control when Agent 
purges messages, see the When to Purge tab of the Properties for Selected Groups dialog box.    For 
more information on purging in general, see About Usenet Message Purging.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

Configure Agent's Hard Disk Usage
The buttons in this box help you define the purging options below.    Agent maintains a database of 
messages for each group and these buttons provide presets for common purging configurations.    
After pressing one of these buttons, check the other values in the dialog box and change them to 
meet your specific requirements.

Purge Read Messages Without Bodies
This control defines when Agent purges messages you did not retrieve but marked read (i.e., you only
retrieved the message's header).    Usually, these are messages that you are not interested in 
reading.    For more information on each option in the list, click On every purge, When the message is 
older than, and When the message is no longer available.

Purge Read Messages With Bodies
This control defines when Agent purges messages you have retrieved and read.    For more 
information on each option in the list, click On every purge; On every purge, delete body only; When 
the message is older than; and Never.

Purge Unread Messages Without Bodies
This control defines when Agent purges messages you have not retrieved or marked read (i.e., you 
only retrieved the message's header).    Usually, you haven't yet decided if you want to read these 
messages.    For more information on each option in the list, click On every purge, When the message
is older than, and When the message is no longer available.

Purge Unread Messages With Bodies
This control defines when Agent purges messages you have retrieved but not yet read.    For more 
information on each option in the list, click On every purge; On every purge, delete body only; When 
the message is older than; and Never.

Always get complete list of available messages from server
When checked, Agent retrieves a complete list of available messages whenever it gets new headers.  
This option is useful (but not required) when you have selected the "When the message is no longer 
available" option in one of the controls above.    It does, however, increase the time required to get 
new headers.    For a group containing 500 messages, it increases the download time by about five 
seconds for a 14.4 kbps modem connection.
When unchecked, Agent purges messages with numbers lower than the range of available messages
reported by the news server.    Since there are often gaps in the available range of messages, this 
setting may cause Agent to keep messages that are no longer available.

See Also:
Marking Messages Read
Compacting Agent's Database Files



Default Properties for All Groups dialog box (Group menu)
What to Purge Tab
Use this dialog box to define your default group settings.    This tab controls which Usenet messages 
Agent automatically purges (deletes).    To control when Agent purges messages, see the When to Purge 
tab of the Default Properties for All Groups dialog box.    For more information on purging in general, see 
About Usenet Message Purging.

Configure Agent's Hard Disk Usage
The buttons in this box help you define the purging options below.    Agent maintains a database of 
messages for each group and these buttons provide presets for common purging configurations.    
After pressing one of these buttons, check the other values in the dialog box and change them to 
meet your specific requirements.

Purge Read Messages Without Bodies
This control defines when Agent purges messages you did not retrieve but marked read (i.e., you only
retrieved the message's header).    Usually, these are messages that you are not interested in 
reading.    For more information on each option in the list, click On every purge, When the message is 
older than, and When the message is no longer available.

Purge Read Messages With Bodies
This control defines when Agent purges messages you have retrieved and read.    For more 
information on each option in the list, click On every purge; On every purge, delete body only; When 
the message is older than; and Never.

Purge Unread Messages Without Bodies
This control defines when Agent purges messages you have not retrieved or marked read (i.e., you 
only retrieved the message's header).    Usually, you haven't yet decided if you want to read these 
messages.    For more information on each option in the list, click On every purge, When the message
is older than, and When the message is no longer available.

Purge Unread Messages With Bodies
This control defines when Agent purges messages you have retrieved but not yet read.    For more 
information on each option in the list, click On every purge; On every purge, delete body only; When 
the message is older than; and Never.

Always get complete list of available messages from server
When checked, Agent retrieves a complete list of available messages whenever it gets new headers.  
This option is useful (but not required) when you have selected the "When the message is no longer 
available" option in one of the controls above.    It does, however, increase the time required to get 
new headers.    For a group containing 500 messages, it increases the download time for each group 
by about five seconds for a 14.4 kbps modem connection.
When unchecked, Agent purges messages with numbers lower than the range of available messages
reported by the news server.    Since there are often gaps in the available range of messages, this 
setting may cause Agent to keep messages that are no longer available.

See Also:
Marking Messages Read
Compacting Agent's Database Files



On every purge
Select this option to purge this type of message every time Agent purges any messages from the 
newsgroup.    This option reduces the amount of clutter in the Message List pane, but prevents you from 
reading messages that you may have overlooked in previous sessions.



When the message is older than
Select this option to purge this type of Usenet message when it is older than the specified number of 
days.



When the message is no longer available
Select this option to purge this type of message when it is purged from the news server's list of 
messages.    This setting makes the list of messages displayed by Agent a mirror image of those available
from the server.



On every purge, delete body only
Select this option to purge the body of this type of message every time Agent purges any messages from 
the newsgroup.    Purging only bodies saves hard disk space while still allowing you to maintain a 
complete list of messages.



Never
Select this option to prevent messages of this type from being purged.    As an alternative to this option, 
you may want to consider keeping the important messages (highlight the message and choose Keep 
Message from the Message menu) or moving them to a folder.



Properties for Selected Groups dialog box (Group menu)
When to Purge Tab
This tab controls when Agent automatically purges (deletes) Usenet messages.    To control which 
messages Agent purges, see the What to Purge tab of the Properties for Selected Groups dialog box.    
For more information on purging in general, see About Usenet Message Purging.

Note: These control affect when all groups are purged, not just the selected one.

Purge - When retrieving new headers
When checked, Agent purges messages from a newsgroup when it retrieves new headers for that 
group.

Purge - When closing Agent
When checked, messages from all newsgroups are purged when you exit Agent.

Compact - After manual purges
When checked, selecting a Purge Messages option from the Group menu also compacts your 
databases.    Note: A database is compacted only when the percent of disk space saved is greater 
than the value entered in the "Compact only if wasted space at least..." field below.

Compact - When closing Agent
When checked, Agent will compact all your databases when it closes.    Note: A database is 
compacted only when the percent of disk space saved is greater than the value entered in the 
"Compact only if wasted space at least..." field below.

Compact only if wasted space at least...
Before compacting a database, Agent checks to see how much disk space would be saved by the 
compact operation.    This setting allows you to bypass the potentially time-consuming operation if 
only a small amount of disk space would be saved.    Enter the minimum amount of disk space 
savings, as a percentage of the total size of the database, that will cause Agent to perform an 
automatic compaction after either a manual purge and/or an automatic purge during exit.

When closing Agent, prompt for confirmation...
When checked, Agent asks for confirmation before purging and/or compacting databases when you 
close the program.    When unchecked, the Agent will purge and/or compact the databases without 
asking first.    Note: To purge or compact databases on exit, be sure to check the appropriate box 
above.

See Also:
Compacting Agent's Database Files



Default Properties for All Groups dialog box (Group menu)
When to Purge Tab
Use this dialog box to define your default group settings.    This tab controls when Agent automatically 
purges (deletes) Usenet messages.    To control which messages Agent purges, see the What to Purge 
tab of the Default Properties for All Groups dialog box.    For more information on purging in general, see 
About Usenet Message Purging.

Purge - When retrieving new headers
When checked, Agent purges messages from a newsgroup when it retrieves new headers for that 
group.

Purge - When closing Agent
When checked, messages from all newsgroups are purged when you exit Agent.

Compact - After manual purges
When checked, selecting a Purge Messages option from the Group menu also compacts your 
databases.    Note: A database is compacted only when the percent of disk space saved is greater 
than the value entered in the "Compact only if wasted space at least..." field below.

Compact - When closing Agent
When checked, Agent will compact all your databases when it closes.    Note: A database is 
compacted only when the percent of disk space saved is greater than the value entered in the 
"Compact only if wasted space at least..." field below.

Compact only if wasted space at least...
Before compacting a database, Agent checks to see how much disk space would be saved by the 
compact operation.    This setting allows you to bypass the potentially time-consuming operation if 
only a small amount of disk space would be saved.    Enter the minimum amount of disk space 
savings, as a percentage of the total size of the database, that will cause Agent to perform an 
automatic compaction after either a manual purge and/or an automatic purge during exit.

When closing Agent, prompt for confirmation...
When checked, Agent asks for confirmation before purging and/or compacting databases when you 
close the program.    When unchecked, the Agent will purge and/or compact the databases without 
asking first.    Note: To purge or compact databases on exit, be sure to check the appropriate box 
above.

See Also:
Compacting Agent's Database Files



Properties for Selected Groups dialog box (Group menu)
Retrieving Tab
Use this dialog box to define settings for the selected newsgroup.    TIP:    If you highlight several groups 
before opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab controls how and what Agent retrieves from the news server.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

Retrieve bodies for all new messages
Check this box to have Agent automatically retrieve the bodies for all new Usenet messages at the 
same time it retrieves the headers.    This option is handy if you know you'll always want to read all of 
the messages in a particular group.    Of course, it takes a lot longer to retrieve the bodies, so you 
probably don't want to select this option for all groups.

Do not retrieve messages longer than...
Check this box and enter a value to limit the size of bodies that are automatically retrieved by the 
option above.    For example, you may want to read most of the messages in a particular group, but 
not necessarily download the group's FAQ every time it is posted.    If you know the FAQ is usually 
over 200 lines long, limit the maximum size to 200 lines.

Limit number of headers retrieved per session to...
Check this box and enter a value to limit the number of headers retrieved each time you retrieve new 
headers for the group.    For example, if you limit the number to 100 headers, Agent will retrieve no 
more than the 100 most-recent messages.    This option is handy if you want to catch up with a busy 
group, and know you can't possibly read all the messages posted since you last checked.    Note: This
setting only affects the Get New Headers in Subscribed Groups and the Get New Headers in 
Selected Groups commands.    For more information on these commands, see Online Menu 
Commands Explained.

View Empty Group Action
Select the option corresponding to the action you want Agent to take when you double-click or press 
Enter on an empty newsgroup.

Maximum messages to sample
Enter the maximum number of messages to sample.

Highest message retrieved
This is the highest message number Agent has retrieved for this newsgroup.    When you get new 
headers in this group, Agent will retrieve all messages whose number is greater than this value.    You 
may never need to change this setting.    To get all the messages in a group, regardless of the high 
message number, choose Get All Headers in Selected Groups from the Online menu.    To set the 
high message number to the highest value on your news server without retrieving all the new headers
in the group, choose Catch Up With Selected Groups from the Online menu.

See Also:
Online Menu Commands Explained



Default Properties for All Groups dialog box (Group menu)
Retrieving Tab
Use this dialog box to define your default group settings.    This tab controls how and what Agent retrieves 
from the news server.

Retrieve bodies for all new messages
Check this box to have Agent automatically retrieve the bodies for all new Usenet messages at the 
same time it retrieves the headers.    This option is handy if you know you'll always want to read all of 
the messages in a particular group.    Of course, it takes a lot longer to retrieve the bodies, so you 
probably don't want to select this option for all groups.

Do not retrieve messages longer than...
Check this box and enter a value to limit the size of bodies that are automatically retrieved by the 
option above.    For example, you may want to read most of the messages in a particular group, but 
not necessarily download the group's FAQ every time it is posted.    If you know the FAQ is usually 
over 200 lines long, limit the maximum size to 200 lines.

Limit number of headers retrieved per session to...
Check this box and enter a value to limit the number of headers retrieved each time you retrieve new 
headers for the group.    For example, if you limit the number to 100 headers, Agent will retrieve no 
more than the 100 most-recent messages.    This option is handy if you want to catch up with a busy 
group, and know you can't possibly read all the messages posted since you last checked.    Note: This
setting only affects the Get New Headers in Subscribed Groups and the Get New Headers in 
Selected Groups commands.    For more information on these commands, see Online Menu 
Commands Explained.

View Empty Group Action
Select the option corresponding to the action you want Agent to take when you double-click or press 
Enter on an empty newsgroup.

Maximum messages to sample
Enter the maximum number of messages to sample.

See Also:
Online Menu Commands Explained



Properties for Selected Groups dialog box (Group menu)
Attachments Tab
Use this dialog box to define settings for the selected newsgroup.    TIP:    If you highlight several groups 
before opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab defines the directory where Agent saves binary attachments.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

Binary Attachments Directory
Enter the directory where you want Agent to save binary attachments decoded from this group.

See Also:
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent



 Properties for Selected Groups dialog box (Group menu)
Attachments Tab
Use this dialog box to define settings for the selected newsgroup.    TIP:    If you highlight several groups 
before opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab defines the directory where Agent saves binary attachments.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

Binary Attachments Directory
Enter the directory where you want Agent to save binary attachments decoded from this group.

Use message subject for filename
Check this box to use the message's subject as the filename when saving binary attachments.    
When unchecked, Agent uses the filename stored in the message's uuencoded header instead.

Filename conversions
Select the filename conversion method you want Agent to use when saving a binary attachment.    
Note:    Changing this setting here also changes the corresponding setting in the Default Properties for
All Groups dialog box.
· Retain original filename, if possible - Use the original filename from the message, to the extent

allowed by the destination file system.    Various file systems disallow certain characters and limit 
the maximum filename length, in which case Agent makes the necessary adjustments.

· Convert to DOS 8.3 filename when saving to a DOS volume - If the destination file system is a
FAT volume (i.e., as DOS disk), convert the filename to the traditional 8.3 format.    Note: 
Windows 95 and Windows NT are capable of storing long filenames on FAT volumes.    When this
option is selected, Agent uses the traditional format even if the file system is capable of storing 
long names.    This option is useful if you intend to copy the files to other systems where long 
filenames are not supported. 

· Always convert to DOS 8.3 filename - Always convert to the traditional 8.3 FAT filename format,
even on file systems that support long filenames (e.g., Windows NT's NTFS), FAT with long 
filename support (e.g., Windows 95), and HPFS (e.g., OS/2). 

See Also:
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent



Default Properties for All Groups dialog box (Group menu)
Attachments Tab
Use this dialog box to define your default group settings.    This tab defines the directory where Agent 
saves binary attachments.

Binary Attachments Directory
Enter the directory where you want Agent to save binary attachments.

See Also:
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent



 Default Properties for All Groups dialog box (Group menu)
Attachments Tab
Use this dialog box to define your default group settings.    This tab defines the directory where Agent 
saves binary attachments.

Binary Attachments Directory
Enter the directory where you want Agent to save binary attachments.

Use message subject for filename
Check this box to use the message's subject as the filename when saving a binary attachment.    
When unchecked, Agent uses the filename from the message's uuencoded header instead.

Filename conversions
Select the filename conversion method you want Agent to use when saving a binary attachment.    
Note:    Changing this setting here also changes the corresponding setting in the Properties for 
Selected Groups dialog box.
· Retain original filename, if possible - Use the original filename from the message, to the extent

allowed by the destination file system.    Various file systems disallow certain characters and limit 
the maximum filename length, in which case Agent makes the necessary adjustments.

· Convert to DOS 8.3 filename when saving to a DOS volume - If the destination file system is a
FAT volume (i.e., as DOS disk), convert the filename to the traditional 8.3 format.    Note: 
Windows 95 and Windows NT are capable of storing long filenames on FAT volumes.    When this
option is selected, Agent uses the traditional format even if the file system is capable of storing 
long names.    This option is useful if you intend to copy the files to other systems where long 
filenames are not supported. 

· Always convert to DOS 8.3 filename - Always convert to the traditional 8.3 FAT filename format,
even on file systems that support long filenames (e.g., Windows NT's NTFS), FAT with long 
filename support (e.g., Windows 95), and HPFS (e.g., OS/2). 

See Also:
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent



Find dialog box (Edit menu)
Use this dialog box to find a group, folder, or message.

Find What
Enter the text to search for.

Find First
Press this button to find the first occurrence of the text you entered above.

Find Next
Press this button to find the next occurrence of the text you entered above.

See Also:
Finding Groups, Folders, or Messages



Licensing Agreement dialog box
This dialog box displays Agent's licensing terms and conditions.    You must accept the terms and 
conditions in order to run the program.

Accept
Press this button to accept the terms of the agreement and run Agent.

Decline
Press this button if you do not accept the terms of the agreement.    Agent will not run if you press this 
button.



Page Setup dialog box (File menu)
Use this dialog box to control the format of messages printed with Agent.

Margins
Enter the left, right, top, and bottom margins in inches.

All fields
Select this option to print all of the header information along with the message bodies.

Selected fields
Select this option to print some of the header information along with the message bodies.    In the 
associated text box, enter the names of the fields, separated by commas, you want printed with the 
message bodies.    You can list any field names, including non-standard fields.    Note:    Agent prints a 
field only if it appears in the message.    If you want Agent to print the field even if it doesn't appear in 
the message, precede the field name with an exclamation point (e.g., !Keywords).

No fields (Body only)
Select this option to print only the message bodies.

None
Select this option to print messages one directly after the other.

Between messages
Select this option to insert a page break between each message being printed.

Between threads
Select this option to print all the messages in the same thread one after the other and to insert a page
break between messages of different threads.

Font
Press this button to pick the font used when printing messages.

See Also:
Printing Messages



Server Authorization Password dialog box
Use this dialog box to enter the password required to login to your news server.

Password
Enter the password required by your news server.

Remember password between sessions
Check this box if you want Agent to automatically enter that password for you each time you login to 
the news server.



Refresh Groups List dialog box (Online menu)
Use this dialog box to update your group list and define what Agent should do with groups it no longer 
finds on the news server.

The refresh operation retrieves a complete list of all newsgroups available form the server.    It then adds 
any new groups to Agent's list of groups, and optionally deletes any groups that are no longer available.    
TIP:    If you only want to retrieve new groups added since the last time you updated your group list, 
choose Get New Groups from the Online menu.

Note:    Since this operation retrieves a complete list of groups, it can take several minutes to complete.

Keep all extinct groups
Select this option to maintain groups even if they no longer exist on the server.

Delete extinct groups that are empty
Select this option to maintain groups that no longer exist on the server if the group contains 
messages.

Delete all extinct groups
Select this option to delete any group which no longer exists on the server.

See Also:
Online Menu Commands Explained



Rename Signature dialog box (Signatures dialog box, Options menu)
Use this dialog box to change the name of a signature.

New Name
Enter a new name for the signature.



Save Messages As dialog box (File menu)
Use this dialog box to save one or more messages to a text file.    Note: Agent only saves messages 
whose bodies have been retrieved.

Select all the messages you want to save before choosing this menu option.    If you select a collapsed 
thread, Agent will save all messages in the thread.

File Name
Enter the name of the file you want to save to, or select a file from the list of files. 

Directories
Select the directory where you want to save the file. 

List of File Types
Select the type of files you want to display in the list of files. 

Drives
Select the drive where you want to save the file. 

Append to Existing File
Check this box if you want to append the messages to an existing file.    If you uncheck this option and
save the messages to an existing file, Agent will erase the current contents of the file.

UNIX message file
Select this option and Agent will save the messages in the standard UNIX message format.    In this 
format, messages begin with a "From <user>@<domain> <date>" line.    This options also 
causes Agent to add a ">" before any body line that begins with "From<space>" and 
contains an "@" character anywhere in the line.

Precede each message with...
Select this option and Agent will add the specified text to the beginning of each message
it saves.    You can include the codes \n, \t, \f, and \\ in the specified text to represent 
newlines, tabs, formfeeds, and backslashes, respectively.

No separator between messages
Select this option if you do not want Agent to include any additional text between the saved 
messages.

All fields
Select this option to save all of the header information along with the message bodies.

Selected fields
Select this option to save some of the header information along with the message bodies.    In the 
associated text box, enter the names of the fields, separated by commas, you want saved with the 
message bodies.    You can list any field names, including non-standard fields.    Note:    Agent writes a
field only if it appears in the message. If you want Agent to write the field even if it doesn't appear in 
the message, precede the field name with an exclamation point (e.g., !Keywords).

No fields (Body only)
Select this option to save only the message bodies.

See Also:
Printing Messages



Agent Setup dialog box
Fill in this dialog to provide Agent with the basic information needed to communicate with your news and 
mail servers.    If you don't want to post messages, you only need to supply the name of your news server 
and your time zone.    You can enter the other information later in the Preferences dialog box.

Use Information From Another Program
If you're already using one of the listed programs, Agent can get most of its basic setup information 
from the other program's configuration files.    Press this button to select the program you use.

News (NNTP) Server
Enter the name of your news (NNTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Email (SMTP) Server
Enter the name of your email (SMTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Email Address
Enter your email address.    When you send a message, this address appears in the "From" field.    
For example: john.doe@forteinc.com

Full Name
(Optional) Enter your full name.    This name is included with your email address in messages that you
send.    It is helpful to include your full name if your email address does not contain your name.    Also, 
some programs, such as Agent, can display an author's full name rather than his/her email address.

Time Zone
Select the time zone you are located in.    Agent uses the time zone to convert the dates of messages 
to your own local time.    Also, when you post a message, Agent includes your time zone in the date.

Automatically adjust for Daylight Saving Time
Check this box if you live in a locality that observes Daylight Saving Time between April and October.  
During these months, Agent automatically adjusts your time zone to compensate for the time 
difference.

Spell Check Language
(Not available in Free Agent) Select the default language dictionary to use for spell checking 
messages.    For more information, see About Agent's Dictionaries.

Exit Agent
Press this button if you don't have the basic information available.    The next time you run Agent, this 
dialog box will be displayed again.



Signatures dialog box (Options menu)
Use this dialog box to define the signatures you wish to use in messages you send.

Names
This is a list of the signatures you have defined.    To edit a signature, select it in this list and enter the 
new text in the controls below.

Add
Press this button to create a new signature.

Rename
Press this button to rename the signature highlighted in the Names list.

Delete
Press this button to delete the signature highlighted in the Names list.    If you accidentally delete a 
signature, press the Cancel button to close the dialog box and cancel all of your changes.

Default Signature
Select the signature you wish to use by default.    Select [None] if you don't want to have a default 
signature.    When you post a message, Agent automatically uses your default signature.    You can 
choose a different signature to be the default for each newsgroup (see the Posting tab of the 
Properties for Selected Groups dialog box) or override the signature used for a specific message (see
the Compose Usenet Message window).    Note: Changing this setting here also changes the 
signature set on the Posting tab of the Default Properties for All Groups dialog box.

Text
Enter the text of the signature highlighted in the Names list. If you want a blank line or other separator
to appear between the rest of the message and the signature, you need to include it here.    To insert 
a TAB in the text, press Ctrl+TAB.
TIP:    A common convention on the Internet is to begin your signature with a line containing two 
dashes.    For example:
--
Dave Chin
Forte, Inc.

Use existing file
If you want to share a signature file with another program, enter the name of the file that contains the 
signature.    When you have entered a valid file name, the dialog will display the contents of the file in 
the Text field.    Any changes you make to the signature in this dialog box will be saved to the file, so 
changes here also affect any other program that is using the same file.
TIP: The name of the signature file for the Eudora email program is SIGNATUR.PCE, and it is stored 
in the directory where you installed Eudora.

Browse
Press this button to browse for a signature file.

See Also:
How to Post Usenet Messages
How to Send Email



Signatures
A signature is one or more lines of text that Agent automatically places at the bottom of messages you 
send.    You can define as many signatures as you wish.    When you create a new message, you can 
select which signature to use with that message.    For example, you can define a "personal" signature 
and a different "business" signature.



Manually Save Binary Attachment dialog box (File menu)
Use this dialog box to manually save an attachment when Agent can't automatically find all the messages 
composing the attachment.    For more information on retrieving attachments, see How to Retrieve a 
Binary Attachment.

Messages
This is a list of all the messages you selected before opening the dialog box.    If this list does not 
contain all the messages in the attachment, press Cancel and select the remaining messages by 
holding down the Control key and clicking on them.    If the messages are out of order, press the Up 
and Down buttons to get them in order.

Up / Down
Press these buttons to move the highlighted message up or down in the list.    Before launching or 
saving an attachment, you must make sure that the messages are in the correct order.

Launch
Press this button to view the attachment.    Agent first saves the attachment (see below for more 
information) and then passes it to the application associated with the attachment's file type.    For 
more information, see How to Configure a GIF or JPG Viewer to Work with Agent.

Save
Press this button to save the attachment as a file.    Agent saves the attachment in the directory 
specified in the Attachments tab of the Properties for Selected Groups dialog box.

If you are offline and have not yet retrieved the attachment's messages, Agent will immediately go online 
to download and decode the attachment after you press Launch or Save.



View Empty Group dialog box
This dialog box is displayed when you double-click or press Enter on a newsgroup with no messages and 
your View Empty Group Action in the Retrieving tab of the Properties for Selected Groups dialog box is 
set to "Prompt for action."

Sample 50 Message Headers
Press this button to retrieve a maximum of 50 message headers for this group.    Note: The number 
you see may not be 50.    The sample size is defined in your Default Properties for All Groups dialog 
box on the Retrieving tab.

Get All Message Headers
Press this button to retrieve all message headers in this group.

Subscribe to Group
Press this button to subscribe to the group.    You can retrieve message headers later by choosing Get
New Message Headers in Subscribed Group from the Online menu.

See Also:
Online Menu Commands Explained



Select Signature File dialog box (Signatures dialog box, Options menu)
Use this dialog box to find a signature file on your hard disk.

File Name
Enter the name of the signature file, or select a file from the list. 

Directories
Select the directory where you want to select the file from. 

List of File Types
Select the type of files you want to display in the files list. 

Drives
Select the drive where you want to select the file from.



Save Attachment File dialog box (View Binary Attachment dialog box, File menu)
This dlg is obsolete.
Use this dialog box to save an attachment as a file.

File Name
Enter the name of the file. 

Directories
Select the directory where you want to save the file. 

List of File Types
Select the type of file you want to save the attachment as.

Drives
Select the drive where you want to save the file.



Attach Binary File dialog box (Compose window)
Use this dialog box to attach a binary file to a message.    Agent will automatically uuencode the file for 
you.    Note: If you want to insert a text file into the message, choose Insert Text File from the File menu 
instead.

File Name
Enter the name of the file to attach, or select a file from the list. 

Directories
Select the directory where you want to select the file from. 

List of File Types
Select the type of files you want to display in the files list. 

Drives
Select the drive where you want to select the file from.

See Also:
How to Post Usenet Messages
How to Send Email



Insert Text File dialog box (File menu)
Use this dialog box to insert a text file into a message.

File Name
Enter the name of the file to insert, or select a file from the list. 

Directories
Select the directory where you want to select the file from. 

List of File Types
Select the type of files you want to display in the files list. 

Drives
Select the drive where you want to select the file from.

See Also:
How to Post Usenet Messages
How to Send Email



Browser Font dialog box (Options menu)
Use this dialog box to pick the font that groups, folders, and messages are displayed in.
Note: Message subjects are displayed in the font controlled by the Message Subject Font dialog box.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

See Also:
Message Text Display Options



Message Subject Font dialog box (Options menu)
Use this dialog box to pick the font that message subjects are displayed in.
Note: The other items in the Message List pane (e.g., number of lines and author) use the font controlled 
by the Browser Font dialog box.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular.    Message subjects can 
be easier to read if you select a bold font style.

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

See Also:
Message Text Display Options



Variable-Pitch Body Font dialog box (Options menu)
Use this dialog box to pick the variable pitch font that message bodies are normally displayed in.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

See Also:
Message Text Display Options
Fixed-Pitch Body Font dialog box



Fixed-Pitch Body Font dialog box (Options menu)
Use this dialog box to pick the fixed pitch font that message bodies are displayed in when you choose 
Fixed Pitch Font from the Message menu.

Font
Type or select a font name.    Courier and Courier New are two examples of fixed pitch fonts.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

See Also:
Message Text Display Options
Variable-Pitch Body Font dialog box



Printer Font dialog box (Page Setup dialog box, File menu)
Use this dialog box to pick the font used when printing messages.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.



Compose Usenet Message window (Post menu)
Use this window to create a message to post in a newsgroup.    For more information, see How to Post 
Usenet Messages

Newsgroups
Enter the name of the newsgroup you wish to post to.    To post the same message on multiple groups
(cross-post), enter the names of all the groups separated by commas (e.g., alt.usenet.offline-
reader,alt.winsock).

Subject
Enter a brief phrase describing the message.

Email To
(Optional) Enter the email addresses of people you wish to send copies of your posting to.    If you are
posting a follow-up message and want to email a copy of your posting to the original message's 
author, select his/her email address from the drop-down list.    To send an email to more than one 
person, enter all the email addresses separated by commas (e.g., 
john.doe@forteinc.com,jane.doe@forteinc.com).
Note: If you usually copy the original message's author when posting follow-ups, check the "Copy 
follow-up messages to author via email" box on the Posting tab of the Default Properties for All 
Groups dialog box to initialize this field accordingly.

Attachment
(Optional) Enter the name of the file to attach to the message or press the Attachment button to 
browse for the file.    For more information, see How to Send a Binary Attachment.

All Fields
Press this button to show and change the other fields that apply to the message.    Press this button 
again to hide the extra fields.

Fields
This is a list of all the fields that apply to the message.    See Message Fields for a description of each
field.    To change a particular field's value, highlight the field and enter the value in the "Value for 
<Field>" control below.    If a field has "Default" next to it, it's using the default value defined on the 
Posting tab of the Properties for Selected Groups dialog box.

Value for <Field>
The desired value for the field selected above.    If you change a field's value and later decide to revert
back to its default value, check the Use Default box to the right of this control.

Signature
Select the signature to place at the bottom of this message.    Choose [None] if you don't want a 
signature added to the message.    You can view, modify, or create signatures with the Signatures 
dialog box.    You can also define a different default signature for each group with the Posting tab of 
the Properties for Selected Groups dialog box.
Note: Agent does not display your signature in this window.    It will add the signature to the message 
when transmitting it to the Internet.

Filing
Select the folder in which to file the message.    Choose "[Leave in Outbox]" to save the message in 
your Outbox or choose "[Delete]" to have Agent delete the message after sending it.

Send Now
Press this button to immediately transmit your message to the Internet.    This button appears dim 
when the Newsgroups field is blank.

Send Later
Press this button if you use Agent off line and you have other messages you want to send.    This 
button appears dim when the Newsgroups field is blank.
Once you have composed all your messages, select Post Usenet and Email Messages from the 



Online menu to transmit them to the Internet.    Note: Agent does not make a copy of the attached file 
prior to sending it.    If you press Send Later, make sure that the file stays around until you transmit the
message.

Save
Press this button to save your message without sending it.    The message will appear in your Outbox. 
To view your Outbox, choose Open Outbox from the Window menu.    You can double-click the 
message in the Outbox to edit and/or send it.

See Also:
How to Send Email
Making Sure Messages Were Sent Properly
How to Re-send a Message You Created
Message Text Display Options
Spelling dialog box
About Agent's Dictionaries.
ROT13 Encoding and Decoding



Compose Email Message window (Post menu)
Use this window to create an email.    For more information, see How to Send Email

To
Enter the recipient's email address.    To send the same email to more than one person, enter all the 
email addresses separated by commas (e.g., 
john.doe@forteinc.com,jane.doe@forteinc.com).

Subject
Enter a brief phrase describing the message.

Attachment
(Optional) Enter the name of the file to attach to the email or press the Attachment button to browse 
for the file.    For more information, see How to Send a Binary Attachment.

All Fields
Press this button to show the other fields that apply to the message.    Press this button again to hide 
the extra fields.

Fields
This is a list of all the fields that apply to the message.    See Message Fields for a description of each
field.    To change a particular field's value, highlight the field and enter the value in the "Value for 
<Field>" control below.    If a field has "Default" next to it, it's using the default value defined on the 
Posting tab of the Default Properties for All Groups dialog box.

Value for <Field>
Enter the desired value for the field selected above.    If you change a field's value and later decide to 
revert back to its default value, check the Use Default box to the right of this control.

Signature
Select the signature to place at the bottom of this message.    Choose [None] if you don't want a 
signature added to the message.    You can view, modify, or create signatures with the Signatures 
dialog box.
Note: Agent does not display your signature in this window.    It will add the signature to the message 
when transmitting it to the Internet. 

Filing
Select the folder in which to file the message.    Choose "[Leave in Outbox]" to save the message in 
your Outbox or choose "[Delete]" to have Agent delete the message after sending it.

Send Now
Press this button to immediately transmit your message to the Internet.    This button appears dim 
when the To field is blank.

Send Later
Press this button if you use Agent off line and you have other messages you want to send.    This 
button appears dim when the To field is blank.
Once you have composed all your messages, select Post Usenet and Email Messages from the 
Online menu to transmit them to the Internet.    Note: Agent does not make a copy of the attached file 
prior to sending it.    If you press Send Later, make sure that the file stays around until you transmit the
message.

Save
Press this button to save your email without sending it.    The message will appear in your Outbox.    
To view your Outbox, choose Open Outbox from the Window menu.    You can double-click the 
message in the Outbox to edit and/or send it.

See Also:
How to Post Usenet Messages
How to Receive Email
Making Sure Messages Were Sent Properly



How to Re-send a Message You Created
Message Text Display Options
Spelling dialog box
About Agent's Dictionaries.
ROT13 Encoding and Decoding



Message Fields
The following table describes the various fields available to you when composing messages.

Field Description
Bcc A list of email addresses (separated by commas) of people to receive a copy of the 

message without the primary recipients (the ones listed in the To and Cc fields) 
knowledge.    If you enter a value for this field when posting a message, it will cause 
Agent to also post an email message to the specified recipients. 

Cc A list of email addresses (separated by commas) of people to receive a copy of the 
message.    If you enter a value for this field when posting a message, it will cause Agent 
to also post an email message to the specified recipients.

Distribution (Usenet messages only) This field is used to alter the distribution scope of the message.   
It is a comma separated list similar to the "Newsgroups" field.    User subscriptions are still
controlled by "Newsgroups", but the message is sent to all systems subscribing to the 
newsgroups on the "Distribution" line in addition to the "Newsgroups" field.    For the 
message to be transmitted, the receiving site must normally receive one of the specified 
newsgroups AND must receive one of the specified distributions.    Thus, a message 
concerning a car for sale in New Jersey might have headers including:

Newsgroups: rec.auto,misc.forsale
Distribution: nj,ny

so that it would only go to persons subscribing to rec.auto or misc. for sale within New 
Jersey or New York.    The intent of this header is to restrict the distribution of a 
newsgroup further, not to increase it.    A local newsgroup, such as nj.crazy-eddie, will 
probably not be propagated by hosts outside New Jersey that do not show such a 
newsgroup as valid.    A follow-up message should default to the same "Distribution" line 
as the original message, but the user can change it to a more limited one, or escalate the 
distribution if it was originally restricted and a more widely distributed reply is appropriate.

Expires (Usenet messages only) The date you want the message to expire. 

Followup-To (Usenet messages only) The newsgroups where you want follow-up messages posted. 

From The email address and optional full name of the person who posted the message or sent 
the email. 

Keywords Optional keywords to help categorize the message or email message. 

Organization (Usenet messages only) Your organization, company, school, etc. 

Reply-To The email address where you want replies sent.    If you normally want replies sent to 
your From email address, you can leave this field blank. 

Sender The name of the entity responsible for submitting the message or email message to the 
network.    Normally, this field is blank, to indicate that the From field also names the 
submitting entity.    For example, if Rennie Mitchell is visiting George Mitchell and wishes 
to use his computer to post an email message, George would temporarily set his Sender 
field to his own email address and set the From field to Rennie's email address.    This 
indicates that the messages are being submitted by George on Rennie's behalf. 

Summary (Usenet messages only) An optional summary description of the message. 

See Also:
Compose Usenet Message window
Compose Email Message window
How to Post Usenet Messages
How to Send Email



Spelling dialog box (Message menu)
Use this dialog box to check the spelling of your message before sending it.

To spell check the entire message:
· Make sure no text is highlighted in the message's body before starting the spell check.    Note: Agent 

only checks the body of the message for spelling errors.

To spell check only a portion of the message:
· Highlight the desired text before starting the spell check. 

Not in Dictionary / Repeated Word
This control shows the misspelled or repeated word.    The word will also be highlighted in the 
Compose window.    TIP: If you want to edit the word, click this box to copy it to the Change To box.

Change To
Enter the word's correct spelling or pick the correct spelling from the Suggestions list.    If you want to 
remove the word from the message, delete the text from this box and press the Delete button (which 
appears in place of the Change button when you delete all the text here).

Suggestions
This is a list of possible replacement words.    If the list is empty, press the Suggest button.    To have 
Agent automatically make suggestions, press the Options button and check the Always Suggest box.

Ignore
Press this button to leave the found word as-is and continue checking the message.    If you don't 
want Agent to flag this word again, press either the Ignore All or Add buttons (see below for a 
description).

Ignore All
Press this button to leave the found word and any other occurrences of it as-is.    Agent will not stop 
on this word again until you close the program and restart it or you press the Reset Ignore All button 
on the Spell Checking Options dialog box.    Note: Press Options to open the Spell Checking Options 
dialog box.

Start
Press this button to continue the spell check after editing the message.    Note: This button appears 
only after you edit the message.

Change / Delete
Press this button to replace the found word with the one in the Change To box.    Note: This button is 
labeled "Delete" when the Change To box is empty.

Change All / Delete All
Press this button to replace all occurrences of the found word with the word in the Change To box.    
Note: This button is labeled Delete All when the Change To box is empty.

Add
Press this button to add the found word to your custom dictionary.    For more information about your 
custom dictionary, see About Agent's Dictionaries.

Suggest
Press this button to fill the Suggestions box with a list of possible replacement words.    To have Agent
automatically make suggestions, press the Options button and check the Always Suggest box.    TIP: 
If you edit the Change To text, you can press this button to spell check the new word.

Options
Press this button to open the Spell Checking Options dialog box.    This dialog box allows you change 
the language dictionary, edit your custom dictionary, and modify other settings that affect how the 
spell checker behaves.



Spell Checking Options dialog box (Spelling dialog box, Message menu)
Use this dialog box to define various settings that affect how the Agent spell checker behaves.    Except 
where noted, changing a setting on this dialog box also changes it on the Spelling tab of the Preferences 
dialog box.

Language
Select the language dictionary to use while spell checking this message.    Note: Changing this setting
only affects the current message.    To specify a default language for all messages, pick the desired 
language from the Default Language list on the Spelling tab of the Preferences dialog box (Options 
menu).    For more information, see About Agent's Dictionaries.

Always Suggest
Check this box to have the spell checker automatically suggest possible replacements words.

Check for repeated words
When checked, the spell checker will stop when it finds the same word twice in a row.

Words in UPPERCASE
Check this box to have the spell checker ignore words composed of all uppercase letters.

Words with numbers
Check this box to have the spell checker ignore words containing numbers.

Quoted lines
Check this box to have the spell checker ignore words which appear on lines beginning with a quote 
character (as defined by the Quoted Text setting on the Preferences dialog boxes' Display tab).

Reset Ignore All
When you press the Ignore All button during a spelling check, Agent adds the selected word to a 
temporary Ignore All dictionary so that it won't flag the word again.    Normally, this dictionary is 
cleared when you close Agent.    Press this button to immediately clear the Ignore All dictionary.

Custom Dictionary for...
The controls in this group allow you to add and remove words from your custom dictionary.    For more
information, see About Agent's Dictionaries.

To add a word to your custom dictionary:
1. Enter the word into the Edit box.
2. Press the Add button.

To remove a word from your custom dictionary:
1. Select the word from the list.
2. Press the Delete button.

To remove all the words from your custom dictionary:
· Press the Clear button. 



Preferences dialog box (Options menu)
Spelling Tab
Use this dialog box to define various settings that affect how the Agent spell checker behaves.

Default Language
Select the default language dictionary to use for spell checking messages.    You can choose a 
different language to be the default for message to each group (see the Posting tab of the Properties 
for Selected Groups dialog box) or override the language used for a specific message (see the Spell 
Checking Options dialog box).    For more information, see About Agent's Dictionaries.    Note: 
Changing this setting here also changes the Spell Check Language set on the Posting tab of the 
Default Properties for All Groups dialog box.

Always Suggest
Check this box to have the spell checker automatically suggest possible replacements words.

Check for repeated words
When checked, the spell checker will stop when it finds the same word twice in a row.

Words in UPPERCASE
Check this box to have the spell checker ignore words composed of all uppercase letters.

Words with numbers
Check this box to have the spell checker ignore words containing numbers.

Quoted lines
Check this box to have the spell checker ignore words which appear on lines beginning with a quote 
character (as defined by the Quoted Text setting on the Preferences dialog boxes' Display tab).

Reset Ignore All
When you press the Ignore All button during a spelling check, Agent adds the selected word to a 
temporary Ignore All dictionary so that it won't flag the word again.    Normally, this dictionary is 
cleared when you close Agent.    Press this button to immediately clear the Ignore All dictionary.

Custom Dictionary for...
The controls in this group allow you to add and remove words from your custom dictionary.    For more
information, see About Agent's Dictionaries.

To add a word to your custom dictionary:
1. Enter the word into the Edit box.
2. Press the Add button.

To remove a word from your custom dictionary:
1. Select the word from the list.
2. Press the Delete button.

To remove all the words from your custom dictionary:
· Press the Clear button. 



 Spell Checker Not Available
Free Agent does not include a spell checker.    To add a spell checker plus lots of other features to your 
news reader, order Agent today!!



Forté Agent Registration dialog box
This dialog box is displayed the first time you run Agent.    You must enter the registration key you 
received via email into the entry box.    If you have not received your registration key within 24 hours of 
placing your order, please send email to order-question@forteinc.com.
Since registration keys can be very long, you will probably want to copy it from your email program and 
paste it into this dialog box.

To paste the registration key from a standard Windows email program:
1. Highlight the registration key in the email message.    Be sure to highlight the entire key and nothing 

else in the message.
2. Choose Copy from the Edit menu to copy the key to the Clipboard.
3. Run Agent.
4. In this dialog box, click in the entry box and press Ctrl+V to paste the key.



Forté Agent Registration dialog box
This is the shrink-wrapped registration dialog box.



New Folder dialog box (Group menu)
Use this dialog box to create a new folder.

Folder Name
Enter the name for the new folder.

See Also:
Filing Messages in Folders
Filing tab of the Inbound Mail dialog box



New Folder dialog box
Use this dialog box to create a folder for incoming email.    All your incoming mail will be saved in this 
folder.

Folder Name
Enter a name for the folder where incoming mail will be saved.

See Also:
Filing Messages in Folders
Filing tab of the Inbound Mail dialog box



Select Folder for Inbound Mail dialog box
Use this dialog box to select the folder in which you want incoming mail saved.

Folder
Select a folder for your incoming mail.

New Folder
Press this button to create a new folder for your incoming mail.

See Also:
Filing Messages in Folders
Filing tab of the Inbound Mail dialog box



Rename Folder dialog box (Group menu)
Use this dialog box to change an existing folder's name.

Old Name
This is the folder's original name.

New Name
Enter a new name for the folder.

See Also:
Filing Messages in Folders



Copy/Move Message to Folder dialog box (All Folders command, Message menu)
Use these dialog boxes to file a message into a folder that doesn't appear on your Copy/Move to Folder 
flyout menus.

Select all the messages you want to file before opening this dialog box.    If you select a collapsed thread, 
Agent will file all the messages in the thread.

Folders
Select the folder in which you want the messages filed.

Manage Menu
Press this button to open the Manage Folder Menus dialog box.

See Also:
Filing Messages in Folders
Filing tab of the Inbound Mail dialog box



Manage Folder Menus dialog box (Options menu)
Use this dialog box to pick which folders appear on your Copy to Folder and Move to Folder flyout menus 
(Message menu).

Folders
This is a list of all the folders that are not on your Copy/Move to Folder flyout menus.

Add
Press this button to include the folder highlighted in the Folders list on your Copy/Move to Folder 
flyout menus.    This folder will be inserted above the one selected in the Menu list.

Delete
Press this button to remove the folder highlighted in the Menu list from your Copy/Move to Folder 
flyout menus.

Menu
This is a list of the folders that appear on your Copy/Move to Folder flyout menus.    You can have no 
more than 9 folders on your flyout menus.

See Also:
Filing Messages in Folders



Inbound Email dialog box (Options menu)
System Profile Tab
This dialog box contains settings Agent uses when receiving email.    Use this tab to specify the name of 
your mail server and other information required to receive mail.    If you don't have all the information 
required to complete this dialog box, check with your service provider or system administrator.

Receive email with POP
Select this radio button if your incoming email is stored on a POP3 mail server.

POP Server
Enter the name of your POP3 mail server or its IP address.    E.g., mail.mycompany.com.

Account
Enter your account name for the POP Server above.    This is the name you use to log onto the mail 
server in order to receive messages.    E.g., GBrown.

Note: In some other email packages (Eudora, for instance), you enter the POP Server and POP Account 
together, separated by the @ symbol.    E.g., GBrown@mail.mycompany.com.    In Agent, you enter 
these settings separately.

Remember password between sessions
Check this box and type your password into the box below to have Agent automatically enter your 
password when checking for new mail.    When this box is unchecked, Agent will prompt you for your 
password the first time it checks for new mail in each session.

Password
Enter your email account's password if you want Agent to automatically log onto your mail server 
when checking for new mail.    For security, your password appears as asterisks (*) and is stored in an
encrypted format in AGENT.INI.

Receive email with SMTP
Select this radio button if your incoming email is stored on an SMTP mail server.    If you receive from 
an SMTP server, Agent continually checks for new mail whenever you are online.

Load winsock on startup
Check this box if you want to connect to your service provider immediately upon loading 
Agent.    This option allows Agent to receive new mail whenever it is running and online, 
even if you are using another Internet program.
When the box is unchecked, Agent will receive email only when it is online doing 
something else, such as communicating with your news server or sending messages.

See Also:
How to Receive Email



Session
Each time you load Agent, you begin a new session.    The session ends when you close Agent.



Inbound Email dialog box (Options menu)
Checking for Mail Tab
This dialog box contains settings Agent uses when receiving email.    Use this tab to define how often 
Agent checks for new mail and what it does when it finds some.

Automatically check for email every...
Check this box if you want Agent to periodically check for new mail.    Enter the frequency of these 
automatic checks in the associated entry field.    Note: Agent must be loaded in order to check for new
mail.    If you receive mail from an SMTP server, this option is dim because Agent checks for new mail 
continually while online.

Check only when online
Select this option and Agent will check for new mail only if you are already online with your service 
provider.

Unload winsock (hang up) between checks
Select this option to have Agent hang up your modem after checking for new mail.

Leave winsock loaded between checks
Select this option to have Agent remain online after checking for new mail.

Leave messages on server
Check this box to prevent Agent from removing messages from your mail server after 
retrieving them.    Normally, Agent deletes messages from the server as they are 
retrieved.    This option is useful when you retrieve messages from the same email 
account with more than one computer.
Note: Once a message has been retrieved and left on the server, Agent will not retrieve 
the message again.    If you subsequently uncheck this box, Agent will delete all the old 
messages from the server the next time you check for new email.

Skip messages longer than...
Check this box to keep Agent from downloading long email messages.    In the associated
entry field, enter the maximum size of messages Agent is allowed to retrieve.    When 
Agent encounters a message larger than the maximum size, it retrieves the first few 
lines of the message (see "Maximum lines to sample" below) and leaves the entire 
message on the server.    Thereafter, as long as this setting is in effect, Agent will leave 
the message on the server and not retrieve it again.    To force Agent to retrieve the 
message in full, uncheck this box and it will be retrieved the next time you check for new
mail.

Maximum lines to sample
Enter the number of lines to retrieve from messages larger than the maximum message size specified
above.

Display message box
Check this box to have Agent pop up a message when new mail is retrieved.

Play sound
Check this box to have Agent beep or, if you have a sound card installed or the PC Speaker driver 
loaded, play a WAV file when new mail is retrieved.    

WAV file
Enter the location of the WAV file to play when new mail is retrieved.    If you leave this field blank but 
check the Play Sound box, Agent will play the Email Receive sound defined in the Sound module of 
your Windows Control Panel.

Browse
Press this button to search for a WAV file to play when new mail is retrieved.

See Also:



Filing Messages in Folders



Inbound Email dialog box (Options menu)
Filing Tab
This dialog box contains settings Agent uses when receiving email.    Use this tab to define the folders in 
which Agent will automatically file new email messages.

Filters
This is a list of rules you define that controls where Agent files new mail.    When a new message is 
received, Agent checks all the filters in this list, starting at the top, and files the message in the folder 
specified by the first filter it matches.    The last filter in the list is always "[All other messages]."    This 
is a catch-all for messages that do not match any of the other filters.

Add
Press this button to create a new filter.

Edit
Press this button to edit the highlighted filter.

Delete
Press this button to remove the highlighted filter.    Note: You cannot delete the "[All other messages]" 
filter.

Up
Press this button to move the highlighted filter up one position in the Filters list.

Down
Press this button to move the highlighted filter down one position in the Filters list.

See Also:
Filing Messages in Folders



Inbound Email dialog box (Options menu)
Attachments Tab
This dialog box contains settings Agent uses when receiving email. Use this tab to define the directory 
where Agent saves binary attachments received in mail messages.

Automatically decode binary attachments
Check this box to have Agent automatically save binary attachments it detects in new email.    When 
this box is unchecked, you can save binary attachments with the Save Binary Attachments command 
on the File menu.

Directory
Enter the directory where you want Agent to save binary attachments decoded from mail messages.

See Also:
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent



Add/Edit Email Filter dialog box (Inbound Mail dialog box, Options menu)
Use this dialog box to define filter criteria for automatically routing new, incoming email messages into 
folders.    You manage these filters with the Filing tab of the Inbound Email dialog box.

Field to Search
Select the field Agent will examine to determine if the new message matches this filter.    For more 
information on these fields, see Message Fields.

Search For
Enter the text Agent will look for in the field specified above.    If Agent finds this text in the specified 
field, it will file the message in the folder selected below.

Case sensitive
Check this box if you want this filter to apply only when the message has the same combination of 
uppercase and lowercase letters that appear in the Search For text above.

Exact match
Check this box if you want this filter to apply only when the message completely matches the Search 
For text.    For example, when this box is checked, a message with "We all love Agent" would not 
match Search For text of "Agent".

Put in Folder
Select the folder in which messages that match this filter will be filed.

New Folder
Press this button to create a new folder.

See Also:
Filing Messages in Folders



Edit Email Filter dialog box (Inbound Mail dialog box, Options menu)
Use this dialog box to choose the folder where all new email messages which do not match any other 
filter criteria will be filed.

Put all messages...
Select the folder where you want new email messages filed by default.

New Folder
Press this button to create a new folder.

See Also:
Filing Messages in Folders



Import Messages dialog box (File menu)
Use this dialog box to import messages from another program into Agent.    For more information, see 
Importing Email Messages from Another Program.

File Name
Enter the name of the text file to import. 

Directories
Select the directory where the import file is located. 

List of File Types
Select the type of files you want to display in the list of files. 

Drives
Select the drive where the import file is located.

File according to inbound message filters
Select this option and Agent will use the email filters defined in the Filing tab of the Inbound Email 
dialog box to determine the folders in which to file the imported messages.    This option is dim if you 
have not yet opened the Inbound Email dialog box (Options menu) and designated a default inbound 
folder.

Put all messages in folder
Select this option and Agent will file all imported messages in the folder selected in the list on the 
right.

If a message contains an X-Folder field...
Check this box and Agent will file imported messages in the folders specified by the messages' X-
Folder field, overriding the other settings on this dialog box.

Automatically create folders
Check this box and Agent will create the folders specified by the messages' X-Folder fields as 
needed.    When this box is unchecked, imported messages with an X-Folder field specifying a folder 
that doesn't exist are filed according to the radio buttons above.

See Also:
Import File Format
Save Messages As dialog box



Build: 16 bit Agent:
NoFree:    No (Free Agent only topics)
YesMail:    Yes (Receive email topics)
YesFolders:    Yes (All aspects of folders)
YesSpelling:    Yes (Spell check topics)
YesSorting:    Yes (Sorting topics)
NoBit32:    No (Features only available in the 32bit version)



How to Use Agent
Before you start using Agent, please take a quick look at Getting Started.

Once you're up and running, check out the topics below for more help using Agent.

How to Use Agent as an Offline Newsreader
How to Use Agent as an Online Newsreader

How to Receive Email
Importing Email Messages from Another Program

How to Post Usenet Messages
How to Send Email
Making Sure Messages Were Sent Properly
How to Re-send a Message You Created

Filing Messages in Folders

About Message Sorting

How to Send a Binary Attachment
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent

Online Menu Commands Explained

About Usenet Message Purging
Compacting Agent's Database Files
Marking Messages Read

Navigating in Agent
Watching and Ignoring Threads
Message Text Display Options

ROT13 Encoding and Decoding
Copying a WWW URL to the Clipboard
How to Get All the Message Bodies in a Newsgroup
How Agent Knows Which Messages are New
Printing Messages
Finding Groups, Folders, or Messages

Frequently Asked Questions



Frequently Asked Questions
This topic answers some of the most common questions users have about Agent.

How to configure Agent for multiple users
Agent forgets settings or loses all its data
Pressing (M)ark or (I)gnore causes Agent to jump around
Errors reported by the news server
Errors reported by Winsock
Pressing any buttons while offline causes Agent to hang
Headers/Messages are marked as read after performing an online task
How to re-send a failed message
Agent failed to decode a binary file
Expand Threads doesn't always work
How to restore a deleted group
What is the Log window



Log Window (Window menu)
Agent's Log window is for debugging problems with Agent, Winsock, and your servers.    Under normal 
circumstances, you should never have to open it.



How to configure Agent for multiple users
Agent stores its settings and data files in the working directory specified by its Program Manager icon.    
This allows you to easily share a single copy of the program's executable files (i.e., agent.exe and 
agent.hlp) among several users.
To setup Agent for multiple users:
1. Create a directory for the program files (e.g., c:\agent).
2. Create a personal directory for each user (e.g., c:\agent\his and c:\agent\hers).
3. Create a Program Manager icon for each user with the Command Line pointing to the program itself 

(e.g., c:\agent\agent.exe) and the Working Directory pointing to the user's personal directory 
(e.g., c:\agent\his and c:\agent\hers).



Agent    forgets settings or loses all its data
Agent expects to find its setting and data files in the directory in which it runs.    If it can't find them, it 
assumes it is being run for the first time and displays the license screen. It will also "forget" any 
preferences, properties, and subscribed groups you have saved.

To correct this problem, select (single click) the Agent icon on your Program Manager desktop.    On the 
Program Manager menu, select Properties from the File menu.    You will be presented with the Program 
Item Properties dialog box.    Make sure the Working Directory is set to the directory that Agent stored its 
data files (usually the same directory where Agent is installed).

If you run Agent from a program that doesn't allow you specify the working directory, you can pass this 
information to Agent on its command line.    For example, the command to run Agent may look like this:

c:\agent\agent.exe c:\agent



Pressing (M)ark or (I)gnore causes Agent to jump around
Agent automatically skips to the next unread message when you mark a message for retrieval or ignore a 
thread.    If you don't like this behavior, you can disable it from the Navigation tab of the Preferences 
dialog box by unchecking the "Marking or ignoring a message skips to the next unread message" box.



Errors reported by the news server
This topic will help you track down errors reported by your news server and detected by Agent.
441 400 Bad file number Writing history file - Throttling
441 400 loadav [innwatch.load] 305 gt 300
441 Can't send connect request to server, No such File or Directory

These errors all mean that the news server has an internal problem unrelated to anything you are 
doing.    Contact your service provider to have it fixed.    When this happens, Agent saves the 
message you were trying to post in its Outbox    (Window | Open Outbox), so that you can try to send 
it again later, after your news server is working properly.

441 Can't generate Message-ID Error 0
The error is generated internally by the server if either the server is unable to obtain the current date 
and time (from itself), or if it is unable to find out its own host name.    All of this happens after Agent 
has posted the message to the server.    We recommend that you contact your service provider and 
tell them about the error, since it indicates a problem with their server.

441 Posted in the Future
This error means the date/time on the message, as sent by Agent, is more than 24 hours later than 
the current date/time on the news server.    You should double-check your PC's date and time, and the
time zone setting in Agent (on the System Profile tab of the Preferences dialog box).

480 Authentication required for command error trying to post
This error means that your news server requires you to provide authentication before you can post.    
You need to check with your service provider to find out exactly what is required.    In most cases, you 
need to supply the server a user name and password.    Once you get this information from your 
provider, you can enter it on the User Profile tab of the Preferences dialog box.

500 Command not Recognized
Your news server is not configured to handle a command issued by Agent (usually the XOVER or the 
XHDR commands for retrieving information about messages).    Agent requires that the server accept 
one of these commands.    You will need to contact your service provider and see if they can provide a
server that honors these commands.

500 Error trying to connect to server
This error    means that Agent is attempting to log you into your news server, but your server doesn't 
actually require a login.    Go to the User Profile tab of the Preferences dialog box and uncheck the 
"Server requires authorization login" box.

502 Authentication Error
Check to see if your news server really requires authentication.    If it doesn't or if you are not sure, 
open the Preferences dialog box (Options menu), go to the User Profile tab, and uncheck the "Server 
requires authorization login" option.    If you know that your server does require authentication, 
double-check your User Name and Password on this dialog box.

502 You are not in my access file
502 You only have permission to transfer
502 You have no permission to talk

These all indicate that you are not properly set up as an authorized user of the news server.    You will 
have to contact your service provider or news administrator to get this corrected.

550 Addressee unknown
Usually, this means you tried to send an email to someone whose email address was unknown to the 
email server, and the server refused to try to forward the mail to another server.



Errors reported by Winsock
This topic will help you track down errors reported by your Winsock driver and detected by Agent.
10055 WSAENOBUFS

There is not enough memory available for WINSOCK.DLL to create any buffers for Agent.    The 
problem is with low memory (memory below 640k), not overall memory.    Try to free up more 
conventional memory.

10060 WSAETIMEOUT
This may be a case where Agent loads the WINSOCK.DLL, but the winsock driver fails to load.    Try 
loading the driver prior to Agent.    If this works, then make sure the winsock driver is in the DOS path. 
You may also need to free more conventional memory.

10061 Connection refused by server
This error means that the server is either too busy to accept more connections, or possibly has been 
taken down for maintenance.

11004 Host Name not Found
This error means that the Winsock driver was unable to find the host name for your news (NNTP) or 
mail (SMTP) server.    Double-check the name of these servers in the System Profile tab of the 
Preferences dialog box.    Usually, they will be something like "news.company.com" and 
"mail.company.com", where "company.com" is your provider's domain name.    As a workaround, try 
entering the numeric (IP) address for the servers.

11004 No Data of Requested type
An error occurred during initialization of the Winsock driver. Check your Winsock driver setup.



Pressing any buttons while offline causes Agent to hang
Agent is designed to make online and offline newsreading as convenient as possible.    When configured 
for offline use it will automatically connect to your service provider when it needs to go online and 
disconnect as soon as it is through.    To make this process as efficient as possible, you should have only 
one copy of the file WINSOCK.DLL on your drive.    Also, it's best to keep all of the Winsock files (e.g., 
WINSOCK.DLL, TCPMAN.EXE, etc.) in the same directory, and to make sure that this directory is in the 
PATH= statement of your AUTOEXEC.BAT file.



Headers/Messages are marked as read after performing an online task
By default, Agent automatically marks unwanted messages read whenever you retrieve message headers
or bodies.    This makes it easy for you to find the new messages because they will be the only ones that 
are unread. To change this behavior, uncheck the appropriate box on the Marking Read tab of the Default 
Properties for All Groups dialog box.



How to re-send a failed message
By default, whenever you post a Usenet message or send an email, Agent saves it in the Outbox. This 
means that if the post fails for any reason, the message is still there and you can try to post it again. To do
this, select the Post Usenet and Email Messages from the Online menu.

See Also:
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created



Agent failed to decode a binary file
Agent finds the sections of a binary file by searching for messages with identical subject lines, except for 
the "[n/m]" or "n of m" part.    If it finds all the parts, it uses the [n/m] to figure out how to sort them.    In 
most cases, this method works quite well, because most users who post binaries use automated tools 
(like Agent) that conform to this convention.    But, when some users post binaries, they assign a different 
subject line to each message.    When this happens, Agent cannot find all the sections automatically.

The message "Unable to locate any sections" means you selected the [0/m] message, which 
technically isn't part of the binary, and Agent was not able to find messages [1/m] through [m/m].

The message "Only able to locate x of m sections" means that you selected one of the [n/m] sections, 
but Agent couldn't find all of the other m sections.

The message "No binary attachment found" means the binary may have been posted using an 
encoding scheme other than uuencoding. In this case, retrieve the messages as normal message bodies,
then export the file to text using the Save Message As command from the File menu. The file can then be 
decoded using one of the widely available decoding programs such as Wincode or UDEC.

See Also:
How to Retrieve a Binary Attachment



Expand Threads doesn't always work
There are two options on the Navigation tab of the Preferences dialog box (Options menu) that determine 
whether threads are displayed in expanded or collapsed form:

· Show threads initially Collapsed
When checked, all threads will be shown collapsed when you first open a newsgroup. When 
unchecked, they will all be shown expanded.

· Automatically expand threads containing new messages
When checked, threads will be expanded when you jump into them with the Skip to/View Next Unread
Message commands.    Note: They are expanded only if you've already retrieved and read the first 
message in the thread.



How to restore a deleted group
Select Refresh Groups List from the Online menu.    This will rebuild your groups list without affecting the 
unread counters for your remaining groups.    You won't lose any information by performing this action.

See Also:
Delete Group Command



Copyrights
Free Agent, News Agent, and Agent are trademarks and Forté is a registered trademark of Forté 
Advanced Management Software Inc.    Copyright © Forté 1995.

The Sentry Spelling-Checker Engine -- Copyright © Wintertree Software Inc.

Microsoft is a registered trademark and MS-DOS and Windows are trademarks of Microsoft Corporation.

PKZIP is a trademark of PKWARE Inc.

Eudoraä is a trademark of the University of Illinois Board of Trustees, licensed to QUALCOMM Inc.



TBD - Agent Icons
The following table describes what the icons appearing next to groups and messages represent:

Icon Meaning

The message is in the process of being retrieved.



 How to Receive Technical Support
Forté does not provide direct technical support to Free Agent users.    You can, however, receive help with
the program from other users by posting your question in one of the following newsgroups:

· alt.usenet.offline-reader.forte-agent
· comp.os.ms-windows.apps.winsock.news
· WINCON (CompuServe forum)
Information about the latest Free Agent release and answers to the most frequently asked questions can 
be found on our Web site at http://www.forteinc.com/forte/.    For those without convenient 
Web access, we've prepared a downloadable file containing the text (in HTML format) of our web pages.   
You can find this file on our FTP site at ftp.forteinc.com/pub/forte/support.zip.
See Also:
Frequently Asked Questions



How to Receive Technical Support
Agent users are entitled to 90 days of technical support via email.    If you're having a problem using 
Agent, you can send us an email by choosing Support Question from the Post menu.    This option will 
start a properly addressed and formatted message for your question.    If, for some reason, you cannot 
post messages from Agent, send your question to agent-support@forteinc.com.    Be sure to 
include your serial number in the email if you do not send it from Agent.    The serial number can be found 
on the About Agent screen accessible from the Help menu.

If you have a site-based version of Agent, the Support Question menu option is not present.    Please 
contact your system administrator if you are having problems.

Information about the latest Agent release and answers to the most frequently asked questions can be 
found on our Web site at http://www.forteinc.com/forte/.    For those without convenient Web 
access, we've prepared a downloadable file containing the text (in HTML format) of our web pages.    You 
can find this file on our FTP site at ftp.forteinc.com/pub/forte/support.zip.
You can also receive support through various newsgroups.

· alt.usenet.offline-reader.forte-agent
· comp.os.ms-windows.apps.winsock.news
· WINCON (CompuServe forum)
See Also:
Frequently Asked Questions



Agent Features
Forté's commercial newsreader, Agent, includes all the functionality of Free Agent plus the following:

Spell Checker
100,000+ word dictionary with language specific dictionaries available.    Custom dictionary for adding 
your own words.

Folders
Store messages in user-defined folders.

Kill Lists
Automatically ignore messages based on the subject or author. 

Watch Lists
Automatically retrieve messages based on the subject or author. 

Sorting
Display messages in various orders.    E.g., By author or date. 

Filtering
Show only a subset of the messages.    E.g., Show only unread messages. 

Launch URL's
Automatically run your WWW browser or FTP program when you find an interesting URL (e.g., 
<http://www.forteinc.com/forte/>) in a message. 

Read/Write newsrc Files
Support the use of multiple newsreaders (e.g., one at home and another one at work).    Keeps track 
of which messages have been read by both programs. 

Enhanced cross-post management
Reading a cross-posted message in one group marks it read in all other groups. 

Customizable toolbar
Choose which commands appear on the toolbar. 

Advanced Group Searching
Filter the Group Pane to only show groups with specific text in the group's name. 

International Character Support
Display characters from various languages in messages using the standard MIME format. 

MAPI/VIM Support
Integrate Agent email with the corporate email system. 

Receive Email
Receive email from POP and SMTP mail servers. 

Support for MIME Attachments
Encode and decode attachments using the email standard MIME format. 

Address Book
Keep track of people's email addresses and various other information. 

For more information on Agent's features, see our home page at 
<http://www.forteinc.com/forte>.    To purchase your own copy of Agent, see Ordering Agent.



Ordering Agent
Forté is offering a pre-release version of Agent, called Agent .99, to individuals who wish to purchase our 
commercial newsreader product.    Agent .99 includes all the features of Free Agent plus a multilingual 
spelling checker, basic email, folders, and sorting plus free technical support, via email, until 90 days after
the release of Agent 1.0.    By purchasing Agent .99 now, you will also receive a free upgrade to Agent 1.0 
when it's    available.

You can purchase Agent .99 in any of the following ways:

1. Through the World Wide Web.    This is the fastest and easiest way to get Agent.    Forté's ordering 
page is on a secure Netscape Commerce Server, ensuring that your confidential information remains 
confidential.    For details on ordering Agent through the Web, please see our home page at 
<http://www.forteinc.com/forte>.

2. If you don't have convenient Web access, the next best way to order Agent is by fax or mail.    Simply 
print out and complete the Agent Order Form and either fax it to Forté's Agent Order Desk in 
Carlsbad, California at 619.431.6497 or mail it to:

Agent .99
c/o Forté
2141 Palomar Airport Road
Suite 100
Carlsbad, CA 92009

3. If neither of the above methods are suitable, you can call the Agent Order Hotline at 619.431.6496.    
The Hotline is open from Monday to Friday, 7:30 a.m. - 5:00 p.m. Pacific time.



How to Send a Binary Attachment
Attaching files to messages is quick and easy with Agent.    Since the Internet only supports text 
messages, agent automatically translates all non-text attachments to a standard text-based format.    
Follow the steps below to attach a file to a message:

1. Create a new message.
Select one of the options on the Post menu to create the message.    Click here for more help sending
Usent messages and email.

2. Attach the desired file.
Press the Attachment button to browse for the file, or type the file's name directly into the Attachment 
box.    You can control your attachment options with the Attachments tab on the Preferences dialog 
box.

3. Add a text message (optional).
You can include a message along with the attachment.    The message appears before the 
attachment. If you include a message, Agent also includes your signature.

4. Send the message.
If you use Agent on line, press Send Now to immediately transmit your message to the Internet. 
If you use Agent off line and you have other messages you want to send, press Send Later.    Once 
you have composed all your messages, select Post Usenet and Email Messages from the Online 
menu to transmit them to the Internet.
Send Later Note:    Agent does not make a copy of the attached file prior to sending it.    If you press 
Send Later, make sure that the file stays around until you transmit it. 

See Also:
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created



How to Retrieve a Binary Attachment
Many newsgroups are devoted to the distribution of binary files, typically pictures and sounds.    These 
binary files are posted as text attachments to one or more messages.    Agent makes quick work of 
translating the text attachments into their binary equivalent.

To retrieve an attachment:
1. Select any message in the attachment.    In most cases, Agent will be able to find all the messages 

which compose the attachment.    If it can't, usually because the attachment was not posted in one of 
the standard ways (see How Agent finds all the parts of an attachment), follow the steps under "To 
manually save a binary attachment" below. 
If you select messages from more than one attachment, Agent will retrieve all the attachments that 
have any messages selected. 

2. Retrieve and/or view the attachment.    Choose either Save Binary Attachments or Launch Binary 
Attachments from the File menu.    Agent saves all attachments in the directory entered in the 
Attachments tab of the Properties for Selected Groups dialog box.

If you are configured for online use (see the Online Operation tab of the Preferences dialog box for 
details), Agent will immediately begin downloading and decoding the attachment.    Also, if you 
selected the Launch option, once the file has been saved, Agent will run the Windows application 
associated with the attachment's file type (see below). 
If you are configured for offline use, Agent will mark all parts of the attachment for retrieval.    The next 
time you select Get Marked Message Bodies from the Online menu, Agent will download and decode 
the selected attachments (but not automatically launch them). 

Occasionally, you may find multi-part attachments whose subject lines do not match standard convention 
(e.g., they don't include the typical [1/2], [2/2] notation).    To decode such files, you must tell Agent about 
all of the attachments components.

To manually save a binary attachment:
1. Select all the messages that contain the attachment by clicking on one message and then, with the 

Control key depressed, clicking on the remaining messages.
2. Choose Manually Save Binary Attachment from the File menu.
3. Make sure the messages are in order.    If they are not, use the Up and Down buttons in the Save 

Binary Attachment dialog box to order them.
4. Launch or save the attachment by pressing the corresponding button.    If you are offline and have not

yet retrieved the attachment's messages, Agent will immediately go online to download and decode 
the attachment.

Once an attachment is retrieved, the Binary Message icon  appears next to all the messages in the 
attachment.    To view the attachment, simply double-click or press Enter on any one of its messages.    
This causes Agent to launch the application associated with the attachment's file type.    The file type is 
determined by the attachment's filename extension.    For example, "foo.gif" is a GIF file.    For more 
information, see How to Configure a GIF or JPG Viewer to Work with Agent.

After you have viewed an attachment, you may decide that you want to remove it from your hard drive.    
Although you can obviously do this in another program such as File Manager, Agent makes it easy for you
to remove attached files.
To delete a binary attachment:
1. Select any message in the attachment.
2. Choose Delete Selected Binary Attachments from the File menu.



How Agent finds all the parts of an attachment
Agent finds the sections of a binary attachment by searching the current group or folder for messages 
with identical subjects, except for the "[n/m]" or "n of m" part.    In most cases, this works quite well 
because people generally use automated tools (like Agent) to post attachments.    Unfortunately, some 
people assign different subjects to each message (e.g., "foo.jpg [8/8] -- last one!!").    When this happens, 
you can still save the attachment by selecting all of its sections and choosing Manually Save Binary 
Attachment from the File menu.



Getting Started
Getting up and running with Agent is simple.    Just follow the steps below and you'll be reading messages
in no time.

1. Set your online preferences.
Choose Preferences from the Options menu and select the Online Operation tab.    If you wish to stay 
online with your service provider while using Agent, press the Use Online Defaults button.    If you 
wish to minimize your time online, press the Use Offline Defaults button. 

2. Get a list of groups.
If you did not copy the list of newsgroups from another program or retrieve a complete list when you 
first started Agent, select Refresh Group List from the Online menu.    Since there are several 
thousand groups, this may take a while.    Once the groups are retrieved, Agent will display them in 
the Groups/Folders pane.

3. Subscribe to groups.
Scan through the list of groups for ones you want to follow regularly.    To find a particular group, 
choose Find from the Edit menu. 
When you find a group that may be of interest, double-click on it.    If you to want get a feel for the 
group before subscribing, press the Sample 50 Message Headers button.    If you know you're 
interested in the group, press the Subscribe to Group button. 
If you decide later that you're interested in a group, you can subscribe to it by selecting Subscribe 
from the Group menu.    A newspaper  appears next to each subscribed group. 

To unsubscribe from the group, choose the Subscribe menu option again. 
4. View only subscribed groups.

From the Group menu, choose Subscribed Groups and Folders from the Show flyout menu.    Now 
your Groups/Folders pane is filtered to show only the groups you're interested in.    To view all groups 
again, select All Groups and Folders from the Show flyout on the Group menu. 

5. Retrieve message headers in your subscribed groups.
Choose Get New Headers in Subscribed Groups from the Online menu to download all the message 
headers in all your subscribed groups. 
There may be several hundred new messages for each group so this operation may take a while.    
But, since Agent retrieves messages in the background, you can use your computer for other tasks 
while Agent is working. 

6. Browse the message headers.
Once the message headers are retrieved, browse them to see which ones interest you.    If you're 
using the online defaults, simply double-click or press Enter on a message to retrieve it (see How to 
Use Agent as an Online Newsreader for more information).    If you're using the offline defaults, mark 
all the messages you're interested.    To mark a message, select it and press "M" or choose Mark for 
Retrieval from the Message menu.    When a message is marked, the download arrow  appears 
next to it. 

7. Retrieve marked messages.
If you're using the offline defaults you marked several messages in the previous step.    To retrieve the
full text of all marked messages, select Get Marked Message Bodies from the Online menu.    See 
How to Use Agent as an Offline Newsreader for more information. 

TIP: Clicking the right mouse button in a window displays a Context menu, a context-sensitive list of 
common operations.    Simply select an option from the list to quickly perform that action.

See Also:
How to Use Agent
How to Receive Email





Toolbar
The toolbar contains buttons which give you fast access to the most common actions in Agent.
To see what a particular toolbar button does, move the mouse cursor over the button in Agent and a 
ToolTip box will appear with the button's name.



Groups/Folders pane
This is where a list of newsgroups and folders are displayed.    In this pane you can view all newsgroups, 
only subscribed newsgroups, only folders, or only new newsgroups.    To change what is displayed in this 
pane, choose the appropriate option from the Group menu.
TIP: You can also change what is displayed by clicking the header text on the top of this pane.



Message List pane
This is where the messages in the selected group or folder are displayed.    To view messages in another 
group or folder, select it in the Groups/Folders pane.



Unread Counter
This number shows you how many messages in the associated group or folder you have not yet read.



Ignore Thread Icon
When this icon appears next to a Usenet message, Agent will not retrieve new responses to it.    To switch
between ignoring and not ignoring a thread, select Ignore Thread from the Message menu.



Expand Thread Icon
Click this icon to show the message's responses.



Collapse Thread Icon
Click this icon to hide the message's responses.



Number of Responses
This is the number of responses to the message.    To view the responses, click the Expand Thread icon
.



Number of Lines
This is the number of lines in the message.



Message Body Icon
This icon tells you that the body of the message has been retrieved.



Message Body Not Available Icon
This icon tells you that the message has been deleted from your news server and is no longer available 
for retrieval.



Retrieval Icon
This icon tells you that the body of the message is currently being retrieved.



Watch Thread Icon
This icon tells you that Agent will automatically retrieve the bodies of new responses to this Usenet 
message when retrieving new message headers.    To switch between watching and not watching a 
thread, select Watch Thread from the Message menu.



Unread Message
When a message header is displayed in this color it means that you have not yet viewed the message's 
body.



Read Message
When a message header is displayed in this color it means that you have already viewed the message's 
body.



Mark for Retrieval Icon
This icon tells you that the body of the associated Usenet message will be retrieved the next time you 
select Retrieve Marked Messages from the Online menu.

When this icon appears next to a group, one or more messages in the group are marked for retrieval.

To mark or unmark a message, select Mark for Retrieval from the Message menu.



Keep Message Icon
This icon tells you that Agent will not automatically delete (purge) the message.    To prevent a Usenet 
message from being automatically purged, select Keep Message from the Message menu.    To undo the 
Keep status, select Keep Message again.

Agent never automatically purges messages from folders.



Message pane
This is where a message's text is displayed.    To view a different message's body, select the message in 
the Message List pane.



Status Bar
This area displays information about Agent such as the online status (online or offline), the current task, 
and the number of queued tasks.



Zoom Button
Press this button to maximize the Groups/Folders, Message List, or Message pane.    To restore the 
window back to showing all three panes, press the button that looks like this .



Subscribed Group Icon
This icon appears next to subscribed groups.    To switch between subscribing and unsubscribing to a 
group, select Subscribe from the Group menu.    To view only your subscribed groups, select Subscribed 
Groups and Folders from the Show flyout on Group menu.



New Group Icon
This icon appears next to new groups.    To get the list of groups that have been added to your news 
server since the last time you retrieved groups, select Get New Groups from the Online menu.



Follow Up Messages
These messages are responses to the one above them.    Since follow ups have the same subject as their
parent, only the author is shown.



Binary Attachment Icon
This icon tells you that the message contains a binary attachment that has already been decoded.    
Double-click the message to view the attachment.



Message with Attachment
This message contains a binary attachment.    To decode an attachment, choose Launch Binary 
Attachments from the File menu.



Groups and Folders
These are the Usenet newsgroups and folders you have created.    To retrieve message headers in a 
group, select the group and choose Get New Message Headers in Selected Groups from the Online 
menu.    To create a new folder, select New Folder form the Group menu.    Use the mouse to drag and 
drop messages between groups and folders.



Thread
A thread is a series of related messages grouped together.    For example, when people post responses to
a question, the question and all responses together are called a thread.



Follow Up Message
A follow up message is a response to another posting.    Follow ups generally have the same subject as 
the original and appear indented below it.



How to Post Usenet Messages
Reading newsgroups wouldn't be much fun if you couldn't contribute as well.    Fortunately, posting 
messages with Agent is just as easy as reading them.

1. Select the group you wish to post to.
A group is selected when it is highlighted in the Groups/Folders pane or when you are viewing 
messages for it in the Message List pane.    

2. (Optional) Select the message you are responding to.
If your message is a follow up to another posting, select that message first so that your posting is 
properly formatted. 

3. Open a new Posting window.
From the Post menu, choose New Usenet Message or Follow Up Usenet Message, depending on the
type of posting you want. 

4. Fill in the Posting window's fields.
If you selected a newsgroup (and message) before opening the Posting window, most of the fields 
should be filled in for you.    When posting a follow up message, it is common practice on the Internet 
to send a copy of your response via email to the original message's author.    To do this, simply select 
the author's email address from the Email To list.    If you want to override the default signature, press 
the All Fields button and select the desired signature in the Signature list.    For more information filling
in this window, see the Compose Usenet Message window topic. 

5. (Optional) Attach a file.
If you want to attach a file to the new message, enter the file name next to the Attachment button or 
press the Attachment button to browse for the file.    For more information on attaching files, see How 
to Send a Binary Attachment.

6. Send the message.
If you use Agent on line, press Send Now to immediately transmit your message to the Internet. 
If you use Agent off line and you have other messages you want to send, press Send Later.    Once 
you have composed all your messages, select Post Usenet and Email Messages from the Online 
menu to transmit them to the Internet.
Send Later Note: Agent does not make copies of attached files prior to sending them.    If you attach 
a file and press Send Later, make sure that the file stays around until you transmit the message. 

See Also:
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created
How to Send Email
Message Fields
Spelling dialog box
About Agent's Dictionaries.
ROT13 Encoding and Decoding



How to Send Email
With Agent, sending email to people is a snap and sending email replies to messages is even easier.

1. (Optional) Select the message you are responding to or forwarding.
If you're replying to or forwarding a posting, select that message first so that your email is properly 
formatted. 

2. Open a new Posting window.
From the Post menu, choose New Email Message, Reply via Email, or Forward via Email depending 
on the type of email you want to send. 

3. Fill in the Posting window's fields.
If you selected Reply via Email, the required fields should be filled in for you.    Otherwise, fill in at 
least the To and Subject fields.    Press the All Fields button to send "carbon copies" to other people, 
select a different signature, or define other information associated with the message.    For more 
information filling in this window, see the Compose Email Message window topic. 

4. (Optional) Attach a file.
If you want to attach a file to the email, enter the file name next to the Attachment button or press the 
Attachment button to browse for the file.    For more information on attaching files, see How to Send a 
Binary Attachment.

5. Send the email.
If you use Agent on line, press Send Now to immediately transmit your message to the Internet. 
If you use Agent off line and you have other messages you want to send, press Send Later.    Once 
you have composed all your messages, select Post Usenet and Email Messages from the Online 
menu to transmit them to the Internet.
Send Later Note: Agent does not make copies of attached files prior to sending them.    If you attach 
a file and press Send Later, make sure that the file stays around until you transmit the message. 

See Also:
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created
How to Post Usenet Messages 
How to Receive Email
Message Fields
Spelling dialog box
About Agent's Dictionaries.
ROT13 Encoding and Decoding



Making Sure Messages Were Sent Properly
When you first start using a new program, you probably want to make sure it's doing what you told it to 
do.    To make sure your messages have been successfully sent, choose Open Outbox from the Window 
menu.    By default, all the messages you send with Agent appear in this window (see the Posting tab of 
the Preferences dialog box for details).    The icons next to each message tell you the status of that 
message:

Icon Meaning
The message was successfully sent.
A problem occurred sending this message.    Double-click on the message to make sure all the 

fields are filled in correctly and then press Send Now or Send Later to re-send the message.
The message is queued for uploading (you pressed the Send Later button after creating the 

message).    To send the message now, choose Post Usenet and Email Messages from the Online menu.
The message is in the process of being sent.

See Also:
How to Re-send a Message You Created



Watching and Ignoring Threads
As you probably already know, some newsgroups on the Internet are very active.    There can be several 
hundred new postings a day.    To help you cut through some of this noise, Agent provides you with two 
very powerful yet very simple features: Watching threads and Ignoring threads.

Watching Threads
When you're browsing though messages and come upon one that you know you'll be interested in 
responses to, select Watch Thread from the Message menu or press "W."    The Watch Thread icon,
, will appear next to the message.    Agent automatically retrieves the bodies of all responses to 

watched threads when retrieving message headers. 
Note: When you watch a thread with unretrieved messages, Agent automatically marks all the unretrieved
messages in the thread for retrieval and, if the selected message is unretrieved, skips to the next unread 
message (outside of the current thread).    To retrieve the marked messages, select Get Marked Message 
Bodies from the Online menu (for details, see How to Use Agent as an Offline Newsreader).    To keep 
Agent from skipping to the next unread message, uncheck the "Watching an unread message skips to the
next unread message" box on the Navigation tab of the Preferences dialog box.
Ignoring Threads

The opposite of watching threads is ignoring threads.    When you run across a message that you 
know you won't be interested in responses to, select Ignore Thread from the Message menu or press 
"I."    The Ignore Thread icon, , will appear next to all the messages in the thread.    Agent 
automatically marks the message and any responses to it, even those retrieved in later sessions, 
read.    This can significantly reduce the number of new, unread messages presented to you each 
time you get new message headers. 

Note:    After you ignore a thread, Agent automatically skips to the next unread message.    To turn this 
behavior off (keep the focus on the current message), uncheck the "Watching an unread message skips 
to the next unread message" box on the Navigation tab of the Preferences dialog box. 
See Also:
Navigating in Agent
Marking Messages Read



ROT13 Encoding and Decoding
Some Internet messages contain text encoded with a scheme called ROT13.    ROT13 encoded text 
cannot be read without first decoding it.    For example, "Hello World" encoded with ROT13 looks like this: 
Uryyb Jbeyq

To decode a ROT13 message:
Select the encoded text and choose Apply ROT13 from the Edit menu or press Ctrl+R.

To encode a ROT13 message:
Select the text to encode and choose Apply ROT13 from the Edit menu or press Ctrl+R. 

Note: When you decode text in a message you have retrieved, the decoding only affects your display.    If 
you come back to this message later, you will again see the original, encoded text.    Encoding text in a 
message you're creating, on the other hand, affects the actual text.    If you then post the message, other 
people will see it with the text encoded. 

See Also:
How to Post Usenet Messages
How to Send Email



Copying a WWW URL to the Clipboard
Many Internet messages contain addresses of World Wide Web (WWW) pages.    Although Agent doesn't 
directly support Web browsing, it makes it easy for you to copy these addresses, called URLs, to the 
Windows Clipboard for pasting into another program like Mosaic or Netscape.

To copy a WWW URL to the Clipboard:
While viewing a message with a URL, choose Copy WWW URL from the Edit menu or press Ctrl+U.   
Agent will scan the message starting at the cursor's current location, highlight the first URL it finds, 
and copy it to the Clipboard.    To search for another URL, simply press Ctrl+U again.    If Agent can't 
find the URL, you may need to customize the URLPattern setting in AGENT.INI.

To paste a WWW URL into Mosaic:
Launch Mosaic and choose Open URL from its File menu.    Click in the URL field and press Ctrl+V.

To paste a WWW URL into Netscape:
Launch Netscape and choose Open Location from its File menu.    Click in the edit field and press 
Ctrl+V.



Common Internet Acronyms
<BG> Big Grin
<g> Grin
BRB Be right back
BTW By the way
CP Copy protection
FUBAR Fouled up beyond all recognition (or 

repair)
FWIW For what it's worth
FYI For your information
GD&WVVF Grinning, ducking, and walking very, very

fast
GR&D Grinning, running, and ducking
IAE In any event
IANAL I am not a Lawyer
IMHO In my humble opinion
IMO In my opinion
IOW In other words
LOL Laughed out loud
LZ Loser!
OIC Oh, I see
OTOH On the other hand
PITA Pain in the A$$
PMJI Pardon my jumping in
PMFJI Pardon me for jumping in
ROFL Rolling on floor, laughing
ROTFL Rolling on the floor laughing
ROTFLMAO Rolling on the floor laughing my a$$ off
RSN Real soon now
RTFM Read the f@%# manual (or message)
SNAFU Situation normal, all fouled up
TIA Thanks in advance
TPTB The powers that be
TTFN Ta ta for now

How to Get All the Message Bodies in a Newsgroup
Agent provides you with two ways to retrieve the bodies of all the messages in a newsgroup:

To always retrieve all the bodies in a particular group:
1. Select the group(s) for which you want to retrieve bodies.
2. Choose Properties for Selected Groups from the Group menu.
3. Select the Retrieving tab on the Properties for Selected Groups dialog box.
4. Make sure the "Override default settings" box is checked.
5. Check the "Retrieve bodies for all new messages" box.

To retrieve all the bodies in a group on an ad-hoc basis:
1. Select any message in the Message List pane of the group for which you want to retrieve bodies.
2. Choose Select All from the Edit menu or press Ctrl+A.
3. If you are online, choose Get Selected Message Bodies from the Online menu.    If you are offline, 

choose Mark for Retrieval from the Message menu.    You can later retrieve the marked messages by 
selecting Get Marked Message Bodies from the Online menu.

See Also:
How to Use Agent as an Offline Newsreader
How to Use Agent as an Online Newsreader
Online Menu Commands Explained





How to configure a GIF or JPG viewer to work with Agent
The Internet contains a wide variety of graphic images which are usually stored in GIF or JPG formatted 
files.    Although Agent doesn't display these images directly, you can view them from Agent if you have a 
GIF or JPG viewing program.    To configure your system for viewing graphics from Agent:

1. Run File Manager.
From Program Manager, double-click the File Manager icon.

2. Open the Associate dialog box.
Choose Associate from File Manager's File menu. 

3. Create an association.
In the Associate dialog box, enter GIF or JPG into the Files with Extension box.    Enter the full path of 
your graphics viewer into the Associate With box or press Browse to search for the viewer on your 
hard drive. 

See Also:
How to Retrieve a Binary Attachment



How to Use Agent as an Offline Newsreader
If you pay an hourly rate for your Internet connection, an offline newsreader can save you lots of money 
by minimizing the time you are connected to your service provider.    To use Agent as an offline reader, 
follow the steps below:

1. Make sure you are configured for offline operation.
Choose Preferences from the Options menu and select the Online Operation tab.    Press the Use 
Offline Defaults button and Agent will automatically configure itself for offline use. 

2. Get headers for new messages.
To retrieve the headers of all the new messages in all your subscribed groups, choose Get New 
Headers in Subscribed Groups from the Online menu.    If you only want the new headers in a 
particular group, select that group and choose Get New Headers in Selected Groups from the Online 
menu. 

Agent will now go online and retrieve the new headers.    As soon as it is done, it will go offline so that you 
are no longer incurring connect charges. 

All the message headers Agent retrieved will be colored red (assuming you're using Agent's default color 
scheme - see the Preferences dialog box, Colors Tab).    This signifies that the message is new, or 
"unread." 

3. Mark messages for retrieval.
Browse through the message headers just retrieved and look for ones that interest you.    When you 
find one, highlight it and do any one of the following: 

· Click the Mark for Retrieval toolbar icon 
· Choose Mark for Retrieval from the Message menu
· Press the M or Enter key

· Double-click on the message

Repeat the above step for each message whose body you wish to retrieve. 

4. Get marked message bodies.
Once you've marked all the interesting messages in all your groups, choose Get Marked Message 
Bodies from the Online menu. 

Agent will now go online to retrieve the full text of all your marked messages and go offline as soon as it's 
done. 

5. Read the retrieved messages.
Any messages you did not mark in the previous step will automatically have been marked read when 
you retrieved marked message bodies in the previous step (see Marking Messages Read for details). 
You can now use the options on the Navigate menu to quickly find and read the messages you just 
retrieved. 

See Also:
Navigating in Agent
How to Use Agent as an Online Newsreader
About Usenet Message Purging
Online Menu Commands Explained
Watching and Ignoring Threads
Properties for Selected Groups dialog box, Retrieving tab



How to Use Agent as an Online Newsreader
If you don't pay an hourly rate for your Internet connection, you probably want to remain connected to 
your service provider while using Agent.    To use Agent as an online reader, follow the steps below:

1. Make sure you are configured for online operation.
Choose Preferences from the Options menu and select the Online Operation tab.    Press the Use 
Online Defaults button and Agent will automatically configure itself to stay online. 

2. Get headers for new messages.
To retrieve the headers of all the new messages in all your subscribed groups, choose Get New 
Headers in Subscribed Groups from the Online menu.    If you only want the new headers in a 
particular group, select that group and choose Get New Headers in Selected Groups from the Online 
menu. 

Agent will now go online if you're not currently connected.    It will remain online until you manually go 
offline (by exiting the program or deselecting Online from the Online menu) or until it detects an extended 
period of inactivity. 

All the message headers Agent retrieved will be colored red (assuming you're using Agent's default color 
scheme - see the Preferences dialog box, Colors Tab).    This signifies that the message is new, or 
"unread" (see Marking Messages Read for more information). 

3. Read messages.
To read a message, select it and choose View Selected Message from the Navigate menu.    You can 
also read a message by simply double-clicking on it or highlighting it and pressing Enter.    To read the
next unread message, use the View Next Unread Message (Ctrl+N) or View Next Unread Message in
Thread (Ctrl+T) commands on the Navigate menu.    These commands jump to the next unread 
message and retrieve its body at the same time. 

See Also:
Navigating in Agent
How to Use Agent as an Offline Newsreader
About Usenet Message Purging
Online Menu Commands Explained
Watching and Ignoring Threads
Properties for Selected Groups dialog box, Retrieving tab



Message Header
A brief description of a message.    A message's header contains key information about the message, 
such as its author and subject, but does not include the text, or "body," of the message itself.



Message Body
The actual text of a message.    The other components of a message, such as its subject, author, etc., are 
called the message's "header."



Marking Messages Read
New messages you retrieve are initially marked unread.    When you view the message's body, Agent then
marks that message read.    Since you probably don't read all the Usenet messages whose headers you 
retrieve, Agent automatically marks the ones you don't care about as read.

To control when Agent automatically marks messages read:
By default, Agent automatically marks unwanted Usenet messages read whenever you retrieve 
message headers.    This makes it easy for you to find the new messages because they will be the 
only ones which are unread.    To change this behavior, choose Properties for Selected Groups from 
the Group menu and select the Marking Read tab.

Agent never automatically marks messages in folders read.

To manually mark messages read:
Select the messages you want to mark read and choose Mark Message Read from the Message 
menu.    To mark all the messages in a group or folder read, select the group or folder and choose 
Mark Selected Read from the Group menu or Mark All Messages Read from the Message menu 
(these two commands are equivalent).    To mark all the messages in all your groups or folders read, 
choose Mark All Read from the Group menu.

To manually mark a message unread:
Select the messages you want to mark unread and choose Mark Message Unread from the Message 
menu.    To mark all the messages in a group or folder unread, select the group or folder and choose 
Mark All Messages Unread from the Message menu.

See Also:
Watching and Ignoring Threads



About Usenet Message Purging
In general, Agent automatically deletes, or "purges," old Usenet messages for you.

When does Agent purge messages:
There are three times when messages can be purged:

· When retrieving new headers
Agent can purge a newsgroup's old messages whenever it retrieves new message headers for 
that group.    To turn this feature on, check the "When retrieving new headers" box on the When to
Purge tab of the Default Properties for All Groups dialog box.

· When closing Agent
Agent can purge old messages from all newsgroups when exited.    To enable this option, check 
the "When closing Agent" box in the When to Purge group on the When to Purge tab of the 
Default Properties for All Groups dialog box.

· On demand
You can manually purge old messages by selecting one of the options from the Purge 
Newsgroups flyout on the Group menu.    Or, to immediately delete a message without purging 
the other messages in the group, select the message and, from the Message menu, choose 
either Delete Message (to remove the entire message) or Delete Message Body (to remove the 
message's text while continuing to display its header in the Message List pane).    A message will 
appear asking you to confirm the delete action.    To turn off the delete confirmation message, see 
the Confirmations tab of the Preferences dialog box.

Which messages does Agent purge:
Agent provides you many options when deciding which Usenet messages to automatically purge.    
You can purge messages once you've read them or after a certain period of time.    You can even 
setup Agent to mirror your news server - so you'll only see messages that are available for retrieval.    
To define which messages get purged, see the What to Purge tab of the Properties for Selected 
Groups dialog box.

How to prevent Agent from purging a message:
Occasionally you will come across a message that you don't want Agent to automatically purge.    To 
prevent Agent from deleting a message, regardless of the group's purge settings, highlight the 
message and choose Keep Message from the Message menu or press the Keep Message toolbar 
button .    The Keep Message icon, 

, will appear next to the message.    To remove the Keep Message icon, choose the Keep Message 
command again.
Note: When the Keep Message icon appears next to a message, you cannot manually delete the 
message or its body.    You must remove the Keep Message icon first.
See Also:
Compacting Agent's Database Files



Purge Newsgroups Flyout
Subscribed Groups - Purges messages from all your subscribed groups.
Selected Groups - Purges messages from the current group or highlighted groups.
All Groups - Purges messages from all your groups.



Compacting Agent's Database Files
So that Agent can work quickly and efficiently, it does not always ensure that its database files are as 
small as possible.    If disk space is at a premium, there are two ways that you can compact your 
databases to remove the wasted space that may accumulate.

To manually compact the database files:
Choose Compact Databases from the File menu.    Agent will scan the databases to determine how 
much disk space you will save.    After the scan is complete, you may choose to either proceed with 
the compaction or cancel without affecting any files.

To automatically compact the database files:
You define when Agent should automatically compact your databases with the When to Purge tab of 
the Default Properties for All Groups dialog box.    In general, you probably don't need to compact 
your databases automatically.    Compacting after you change your purge settings should be sufficient 
for most people.

See Also:
About Usenet Message Purging



Navigating in Agent
Agent provides you with a rich set of tools for moving between newsgroups, folders, and messages.    
Most of these tools can be accessed from the Navigate menu, the toolbar, and the keyboard.    Although 
you probably won't use all the available options, this topic will make you familiar with them so that you can
choose which navigation techniques best suit you.

Moving between panes
As you probably already know, Agent is composed of three panes: the Groups/Folders pane, the 
Message List pane, and the Message pane.    You can view all three panes at the same time, or, to 
maximize the information you see on-screen, Zoom the Browser window to expand the current pane to fill 
Agent's window.

To Zoom a Browser window:
· Select Zoom Window from the Navigate menu.
· Press "Z".
· Click the Maximize icon  in the pane you wish to expand. 

To view all three panes at the same time (turn Zoom off):
· Select Zoom Window from the Navigate menu.
· Press "Z".
· Click the Restore icon .

You can easily move the focus between the panes with both the mouse and the keyboard.

To move between panes with the mouse:
· When viewing all three panes, simply click on the desired pane. 
· When zoomed in on a pane, click the tab for the pane you wish to view: 

To move between panes with the keyboard:
· Press the Tab key to move from the Groups/Folders pane to the Message List pane to the 

Message pane. 
· Press Shift+Tab or Escape to move in the reverse order. 

Moving between messages
Moving between messages is probably the single most common action you perform in Agent.    That's why
Agent provides you so many different ways to do this.

To move to the previous or next message:
· From the Message List pane, you can use the up and down arrow keys to move between 

messages. 
· From the Message pane, choose Up to Previous Message (or press "U") or Down to Next 

Message (or press "D") from the Navigate menu.    Note: These commands also work in the 
Message List pane. 

To move to the next unread message:
· Press "N" or the Skip to Next Unread Message toolbar icon  to skip to the next unread 

message.    By default, if the next unread message is in a different group or folder, skipping to the 
next unread message causes Agent to open that group or folder and select the first unread 
message.    If you would prefer Agent to move you to the Groups/Folders pane instead (so that 
you can more easily tell when you're done with a group or folder), uncheck the "Skipping to next 
unread message jumps to first unread message in next group" box on the Navigation tab of the 
Preferences dialog box.

· Press "T" or the Skip to Next Unread Message in Thread toolbar icon  to skip to the next 
unread message in the current thread.    This action is handy because when you reach the last follow-up 
message, Agent stops navigating, telling you that the thread is over. 

· Press "S" or the Skip to Next Unread Group toolbar icon  to skip to the first unread message in



the next group or folder.    By default, this action marks all the unread messages in the current 
group or folder as read before skipping to the next one.    This is a convenient way to tell Agent 
that you have read all the interesting messages in the current group.    You can disable this 
behavior by unchecking the "Skipping to next unread group marks all messages in current group 
read" box on the Navigation tab of the Preferences dialog box. 

Navigating and retrieving Usenet messages at the same time
Since you need to retrieve a Usenet message's body before you can read it, Agent allows you to skip to 
an unread message and retrieve it (or mark it for retrieval) in one step.    Note: Whether Agent retrieves 
the message or marks it for later retrieval is controlled by the Viewing Unretrieved Messages When 
Offline radio buttons on the Online Operation tab of the Preferences dialog box.

To retrieve the next unread message:
· Press Ctrl+N or the View Next Unread Message toolbar icon  to skip to the next unread 

message and retrieve it (or mark it for retrieval).    Note: The action is controlled by the same 
preference settings affecting "N" (see above). 

· Press Ctrl+T or the View Next Unread Message in Thread toolbar icon  to skip to the next 
unread message in the current thread and retrieve it (or mark it for retrieval). 

When configured for offline use (see the Online Operation tab of the Preferences dialog box for details), 
you generally mark all the desired messages for retrieval and then retrieve marked message bodies.    By 
default, Agent skips to the next unread message (performs the "N" action) when you mark a message for 
retrieval.    You can turn this behavior off by unchecking the "Marking or ignoring a message skips to the 
next unread message" box on the Navigation tab of the Preferences dialog box.

Expanding and collapsing threads
Agent displays follow-up messages indented under the original message.    To save screen real-estate, 
these threads are initially shown collapsed, so only the top-most message is visible.    When a thread is 
collapsed, the Expand Thread icon  appears next to it.

To expand a thread:
· Click the Expand Thread icon. 
· Select the message and press the "+" key. 
· To expand all the threads in a group, hold down the Shift key while pressing the "+" key. 

When a thread is expanded, the Collapse Thread icon  appears next to it.

To collapse a thread:
· Click the Collapse Thread icon. 
· Select the message and press the "-" key. 
· To collapse all the threads in a group, hold down the Shift key while pressing the "-" key. 

Agent can also automatically expand threads for you.    By default, Agent expands threads when you skip 
to them.    Note: Agent will automatically expand the thread when skip to it only if you have already 
retrieved the body of the original message.    To prevent Agent from expanding threads when you skip to 
them, uncheck the "Automatically expand threads containing new messages" box on the Navigation tab of
the Preferences dialog box.    If you always want all threads expanded, uncheck the "Show threads initially
collapsed" box on the Navigation tab of the Preferences dialog box.

See Also:
Watching and Ignoring Threads
How to Use Agent as an Offline Newsreader
How to Use Agent as an Online Newsreader
Online Menu Commands Explained



Printing Messages
Agent allows you to print one or more messages in a single group or folder with one command.

To print messages:
1. Define how you want the printed messages to appear (margins, fonts, etc.) with the Page Setup 

dialog box.
2. Select all the messages to print.    If you select a collapsed thread, Agent will print all messages in the 

thread.    Agent only prints messages whose bodies have been retrieved. 
3. Choose Print from the File menu.    Press OK on the Print dialog box to start printing the messages. 

See Also:
Save Message As dialog box



Finding Groups, Folders, or Messages
Agent allows you to search for groups and folders by name and for messages by subject and author.

To find a group:
1. Make sure the focus is in the Groups/Folders pane.    Note: You can do this by selecting any group or 

folder in the Groups/Folders pane.
2. Choose All Groups and Folders from the Show flyout on the Group menu.
3. Choose Find from the Edit menu. 
4. Enter any part of the desired group's or folder's name in the Find dialog box.    For example, if you 

enter win into the Find dialog box, Agent will find, among others, alt.winsock, alt.sewing, 
and rec.crafts.winemaking. 

5. Press Find First to find the first group or folder in the Groups/Folders pane with this text in its name.    
Press Find Next to find the first group or folder below the currently selected one with this text in its 
name. 

6. If the found group or folder isn't the one you were looking for, press F3 or choose Find Next from the 
Edit menu to search for the next group or folder with the text you entered. 

To find a message:
1. Make sure the focus is in the Message List pane of the group you want to search.    Note: You can do 

this by selecting any message in desired group.
2. Choose Find from the Edit menu. 
3. Enter any part of the desired subject or name in the Find dialog box. 
4. Press Find First to find the first message whose subject or author contains the text you entered.    

Press Find Next to find the first message below the currently selected one with this text in the subject 
or author fields. 

5. If the found message isn't the one you were looking for, press F3 or choose Find Next from the Edit 
menu to search for the next message in this group that contains the text you entered.



How Agent Knows Which Usenet Messages are New
When you select either Get New Headers in Subscribed Groups or Get New Headers in Selected Groups,
Agent only retrieves the messages that have been posted to the groups since the last time you checked 
for new messages.    

How does Agent know which messages are new and which ones you've previously retrieved?    Every 
time a message is posted to a group, the news server assigns it a number that is one higher than the last 
message posted to that group.    Each time you retrieve headers for a group, Agent keeps track of the 
highest message number retrieved.    This number is stored in the "Highest message retrieved" field on 
the Retrieving tab of the Properties for Selected Groups dialog box.    The next time you tell Agent to 
retrieve new headers for a group, it will retrieve only the headers of messages whose number is greater 
than the "Highest message retrieved" value.

You can reset the high message number by selecting the desired group and choosing Catch Up With 
Selected Groups from the Online menu.    This causes Agent to connect with the news server and query it 
for the highest message number without retrieving any new headers.

See Also:
Online Menu Commands Explained



Online Menu Commands Explained
The Online menu contains the commands which cause Agent to interact with the Internet.    This topic 
describes these actions in detail and provides links to related Help topics.

Get New Headers in Subscribed Groups 
Retrieves all the message headers that have been posted to your subscribed groups since the last 
time you checked for new messages.    By default, Agent marks a group's existing messages read 
before it retrieves new headers for that group.    To change this behavior for all your groups, uncheck 
the "New message headers" box on the Marking Read tab of the Default Properties for All Groups 
dialog box.

Get New Headers in Selected Groups 
Retrieves all the message headers that have been posted to the selected groups since the last time 
you checked for new messages.    By default, Agent marks a group's existing messages read before it
retrieves new headers for that group.    To change this behavior for a particular group, select that 
group and uncheck the "New message headers" box on the Marking Read tab of the Properties for 
Selected Groups dialog box.

See Also:
How Agent Knows Which Messages are New
How to Get All the Message Bodies in a Newsgroup
Marking Messages Read
Retrieving tab of the Default Properties for All Groups dialog box

Get Marked Message Bodies 
Retrieves the bodies of all the messages you marked for retrieval.    Messages from all groups with 
marked messages are retrieved with this command (not just ones from the selected group).    Also, by 
default, messages that were not marked for retrieval are made read when Agent retrieves marked 
message bodies for that group. To change this behavior, uncheck the "Marked message bodies" box 
on the Marking Read tab of the Default Properties for All Groups dialog box.

See Also:
How to Use Agent as an Offline Newsreader

Get Selected Message Bodies 
Retrieves the full text of the selected message(s).    You can also retrieve a message's body by 
double-clicking on the message or by highlighting it and pressing Enter.    Note: Even if you are 
configured for offline use (see the Online Operation tab of the Preferences dialog box for details), 
selecting this menu command causes Agent to go online and retrieve the selected messages.

See Also:
How to Use Agent as an Online Newsreader

Sample 50 Headers from Selected Groups
Retrieves message headers for the 50 most recently posted messages in the selected groups.    This 
command is useful when you are looking at new groups and don't want to get stuck retrieving 
hundreds of headers for a group you may not be interested in.    Note: You can change the number of 
messages retrieved when you sample a group with the Retrieving tab of the Default Properties for All 
Groups dialog box.
If, after sampling some of the headers, you decide that you are interested in the group, choose Get All
Headers in Selected Groups to retrieve the remaining messages.

See Also:
View Empty Group dialog box



Get All Headers in Selected Groups
Retrieves message headers for every message in the selected groups.    In general, you should use 
one of the Get New Headers commands to retrieve messages because they retrieve only the 
messages you haven't seen.    This command is useful, however, after you've sampled some headers 
from a group and want to retrieve the remaining ones.    You can also use this command to retrieve 
messages that you manually deleted or that were automatically purged.

See Also:
About Usenet Message Purging

Catch Up With Selected Groups
Retrieves the highest message number for the selected groups without retrieving any message 
headers.    The next time you get new headers for the groups, Agent will only retrieve messages 
posted after you did the catch up.
Note: Some other newsreaders employ a slightly different implementation of catch up.    When you 
"catch up" in those programs, they do not retrieve the highest message number.    Instead, they simply
mark read the messages you previously retrieved.    You can achieve the same behavior in Agent with 
the Mark Selected Groups Read command on the Group menu.

See Also:
Marking Messages Read

Post Usenet and Email Messages
Transfers any queued messages to the Internet.

See Also:
How to Post Usenet Messages
How to Send Email
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created

Check for New Email
Retrieves new email messages from your POP server.    Note: This command is dim when you are 
configured to receive mail from an SMTP server because Agent automatically receives your SMTP 
mail whenever it goes online.

See Also:
How to Receive Email

Get New Groups
Retrieves all the newsgroups which were added to your news server since that last time you updated 
your group list.    The new groups Agent retrieves will have the New Group icon, , next to them until 
the next time you get new groups.    To view just the new groups, choose Show Only New Groups 
from the Group menu.    Note: On rare occasions, a group may be added to your news server in such 
a way that Get New Groups will not retrieve it.    For this reason, you may want to periodically use the 
Refresh Groups List action instead.

Refresh Groups List
Retrieves a complete list of groups from the news server.    Use this command when you want to 
recover a group you previously deleted or when you want to purge groups that are no longer available
on the news server.

See Also:
Refresh Groups List dialog box



Stop All Tasks 
Causes Agent to immediately abort the current and any pending online tasks.

Online 
Toggles Agent's Online status.    When this menu option is checked (the toolbar button appears 
illuminated), Agent is online and selecting it will take Agent offline.    When this menu option does not 
have a checkmark next to it (the toolbar button appears as above), Agent is offline and selecting it will
cause Agent to connect to your service provider.    You can also press the toolbar button to toggle 
Agent's online status.



Delete command (Group menu)
Use this command to remove a group or folder from Agent.

To remove a specific group or folder :
Select the group or folder and choose Delete from the Group menu.

To remove all extinct news groups:
Choose Refresh Group List from the Online menu.    On the Refresh Group List dialog box, select the 
"Delete all extinct groups" option.

To recover news groups you deleted:
Choose Refresh Group List from the Online menu.



Cancel Usenet Message command (Message menu)
Use this command to remove a Usenet message you posted.    Canceling a message sends a message to
your news server asking it to delete the message.    This message is also passed along to the other news 
servers on the Internet so that they can delete the message as well.    Note: You cannot cancel email 
messages after sending them.

To cancel a Usenet message:
1. Select the message and choose Cancel Usenet Message from the Message menu.    You can only 

cancel your own messages.    Note: Cross-posted messages only need to be canceled from one of 
the cross-posted groups.

2. In the Compose Usenet Message window, press Send Now or Send later to transmit the message to 
your news server.    You should not make any other changes to the message. 

After sending the message, the message will continue to appear in Agent until it's 
automatically pruned or you delete it (see About Usenet Message Purging for details).    Since 
some news servers do not accept cancel requests, you may want to verify that the posting 
was actually deleted.
To verify that the message was deleted:
1. Highlight the message you canceled.
2. Delete the message's body by selecting Delete Message Body from the Message menu. 
3. Try to retrieve the message's body again by choosing Get Selected Message Bodies from the Online 

menu.    If the cancel request was accepted, the Message Body Not Available icon  will appear next 
to the message. 



Message Text Display Options
The following settings control the appearance of message text:

Normal Font
The standard font used to display message text is defined in the Variable-Pitch Body Font dialog box. 

Fixed Pitch Font
You can also display message text in a fixed-pitch font. Many people on the Internet have fancy 
ASCII-graphic signatures.    These signatures will look like a jumble of lines and letters unless they are
displayed in a fixed-pitch font.    To display messages you've retrieved in a fixed-pitch font, choose 
Fixed Pitch from the Message menu.    To display messages you're composing in a fixed-pitch font, 
choose Fixed Pitch from the Compose window's Message menu.    To return to the standard, variable-
pitch font, select the Fixed Pitch menu option again.    You define which fixed-pitch font you want 
Agent to use in the Fixed-Pitch Body Font dialog box.

Word Wrap Lines
Occasionally you will see messages with very long lines that don't fit on your screen.    When this 
happens, simply select Word Wrap from the Message menu and Agent will break these lines at the 
end of the window.
Messages you send are automatically word wrapped at the length defined in the Posting tab of the 
Preferences dialog box.    If your Compose window is narrower than this value, select Word Wrap 
from the Message menu and Agent will wrap your lines when they reach the end of the window.    
Note: This wrapping is for your display only.    When the message is sent, each line is wrapped at the 
value defined in the Preferences dialog box.

Display Header Fields
Messages can have many fields associated with them, only a few of which are important (e.g., 
Subject and Author).    Since you generally don't care about the remaining fields, Agent hides them 
from.    To see these remaining fields, select Show All Header Fields from the Message menu.    For a 
description of what these fields represent, see Message Fields.

See Also:
Compose Usenet Message window
Compose Email Message window



About Agent's Dictionaries
Agent's spell checker supports the following languages:
· American English
· International English
· French
· German
· Italian
· Spanish

To install a dictionary for another language:
1. Download the desired language's dictionary file from our FTP site.    The dictionary files are located in

ftp.forteinc.com/pub/forte/dictionaries/.
2. Unzip the dictionary file into your Agent directory.

(E.g., pkunzip german.zip c:\agent)
After restarting Agent, you can spell check messages in any of the installed languages.

To spell check a message:
While composing the message, choose Spelling from the Message menu.

To set the default language for all messages:
On the Spelling tab of the Preferences dialog box, select the desired language from the Default 
Language drop-down list

To set the default language for all messages to a particular news group:
Select the group and then, on the Posting tab of the Properties for Selected Groups dialog box, pick 
the desired language from the Spell Check Language drop-down list

To override the default language for a particular message:
Press the Options button on the Spelling dialog box to open the Spell Checking Options dialog box.    
Then, select the desired language from the Language drop-down list.

You can also add your own words to Agent's dictionaries.    The spell checker supports one custom 
dictionary for each language.    When you press the Add button on the Spelling dialog box, Agent adds the
selected word to the current language's custom dictionary (press the Options button to see what the 
current language is).

To remove words from your custom dictionary:
1. Open the Spelling tab of the Preferences dialog box (Options menu).
2. In the Default Language drop-down list, choose the language associated with the custom dictionary.
3. Select the word to delete in the Edit list.
4. Press the Delete button.

See Also:
Compose Usenet Message window
Compose Email Message window
How to Post Usenet Messages
How to Send Email



Filing Messages in Folders
With Agent's folders, you can organize and store your messages in any manner you like.

To create a folder:
1. Choose New Folder from the Group menu.
2. Enter a name for the folder and press OK.

Folders appear in the Groups/Folders pane below the newsgroups.

To view folders:
· Choose one of the "Folder" options from the Show flyout on the Group menu. 

There are several ways to file messages in folders:    You can drag and drop them, use the commands on 
the Message menu, or, for inbound email messages, have them automatically filed for you.    Note: You 
cannot file messages without bodies into a folders.

To drag and drop a message into a folder:
1. View all three panes in your Browser window (i.e., make sure the Zoom Window option on the 

Navigate menu is unchecked).
2. Highlight the message in the Message List pane.    
3. Click anywhere on the highlighted message and hold down the mouse button.
4. While continuing to hold the mouse button down, move the mouse cursor over the folder in which you 

want the message filed.
5. By default, Agent will move a message when you drag and drop it.    To copy the message instead, 

press and hold the Control key.
6. Release the mouse button to drop the message into the destination folder.

To file a message into a folder using the menus:
1. Highlight the message in the Message List pane.
2. On the Message menu, click either the Copy to Folder or Move to Folder flyout.
3. Select the desired folder from the flyout or choose All Folders to open a dialog box with a list of all the

folders you've created.    Note: Use the Manage Folder Menus dialog box to display your most 
frequently used folders on the Copy/Move to Folder flyout menus. 

The fastest way to file your incoming email messages is to let Agent do it for you.    You can define a set of
rules which tell Agent where to store each new email message it encounters.    For example, you could 
create a rule that files all incoming email messages with "Agent" anywhere in the subject field into a folder
called "Agent Info."

To have incoming email messages automatically filed:
1. Choose Inbound Email from the Options menu and click on the Filing tab.
2. By default, all new email messages are filed into a folder called "Inbox" (although you may have 

chosen a different name).    Press the Add button to begin defining a new rule by which email 
messages will be filed.

3. In the Add Email Filter dialog box, define the new rule and the destination folder.

To copy or move messages from the Outbox to a folder:
1. Display the Outbox by choosing Open Outbox from the Window menu.
2. Highlight the messages in the Outbox.
3. If you want to drag and drop the messages into a folder, select Tile Vertically from the Window menu 

and make sure the Groups/Folders pane is visible.
4. File the messages into a folder by either dragging and dropping them or choosing the desired folder 

from the Copy to Folder or Move to Folder flyout on the Message menu (see above for more details 
on these two steps).



How to Receive Email
Receiving email with Agent is simple and straightforward.    You can check for new mail with the click of 
your mouse or you can have Agent periodically check for you.

If you receive your email from an SMTP server, Agent continually checks for new mail whenever you are 
online.    If you receive your email from a POP server, however, you must explicitly tell Agent to check for 
new mail.

To check for new mail:
· If you receive mail from a POP server, choose Check for New Email from the Online menu.
· If you receive mail from an SMTP server, choose Online from the Online menu.    Whenever you are 

online, Agent will receive new email from your SMTP server.

To have Agent periodically check for new mail from your POP server:
1. Choose Inbound Email from the Options menu and click on the Checking for Mail tab.
2. Check the "Automatically check for email every" box.

See Also:
System Profile tab of the Inbound Email dialog box
Filing Messages in Folders



About Message Sorting
Agent allows you to sort your messages by thread, subject, author, date, and size.    It remembers the last 
sort you used for each newsgroup and folder, so when you view that group or folder again, the messages 
will be displayed in the same order they were in the last time you viewed the group or folder.

How to sort your messages:
· On the Group menu, click the "Sort by" flyout and choose the desired sort.  Tip: To sort several 

groups or folders at once, select all of them in the Groups/Folders pane before choosing the desired 
sort from the "Sort by" flyout.

· Click on the label above the column you wish to sort by.    For example, to sort by author, click the 
Author button that appears directly above the author column.    Note: To sort by thread or size, click 
the leftmost column until Thread or Size appears in the column label.

By default, Agent displays the most recent messages on the bottom of the Message List pane when 
sorted by date and the smallest messages on the bottom when sorted by size.

To change the order of the date and size sorts:
1. Choose Preferences from the Options menu and click on the Display tab.
2. Check the "Date sorts descending" and/or the "Size sorts descending" box.    Note: You must resort 

the group or folder after checking or unchecking these boxes for the changes to take effect.



Sort
The ordering of messages in the Message List pane.



Importing Email Messages from Another Program
To help smooth the transition from your old email program, Agent allows you to import messages from a 
text file that is in the standard UNIX email message format (RFC-822).    To further facilitate this transition,
you can download a utility from Forté's FTP site which exports messages from Eudora or Pegasus into 
the standard UNIX format.    These utilities can be found at 
<ftp.forteinc.com/forte/converters/>.    Note: If you use an email program other than the ones
mentioned above, check our Web page to see if an export utility has been written for your program since 
this help file was produced.

To import messages from Eudora or Pegasus:
1. Run the export utility from a DOS window with the following command line:

emailcvt <data directory> <filename> [<folder prefix>]
where <data directory> is your email program's database directory and <filename> is the 
name of the DOS file that contains the file Agent will read.    The argument <folder prefix> is 
optional.    If provided, it is appended to the beginning of the names of all Agent folders that are 
created in the import process.    For example, if the folder prefix was "Email" then email will be 
imported into folders called "Email.In", " Email.Out", etc.

2. Choose Import Messages from the File menu.

3. In the File Name box, enter the location of export file from step #1.

4. (Optional) Check the "If a message contains an X-Folder field..." and "Automatically create folders" 
boxes.

5. Press OK to begin the import.

See Also:
Import File Format
Save Messages As dialog box



How to Re-send a Message You Created
Messages you send can be saved in the Outbox or a folder (see Posting tab of the Default Properties for 
All Groups dialog box for details).    The process of re-sending a message you created is slightly different 
based on where the message is located.

To re-send a message from a folder:
1. Highlight the message in the Message List pane.
2. Choose New Copy of Message from the Post menu.
3. (Optional) Change the message as required (e.g., change the recipient).
4. Press either Send Now or Send Later to transmit the message to the Internet.

To re-send a message from the Outbox:
1. Highlight the message in the Outbox.
2. Choose Open from the Message menu.
3. (Optional) Change the message as required (e.g., change the recipient).
4. Press either Send Now or Send Later to transmit the message to the Internet.

See Also:
Compose Usenet Message window
Making Sure Messages Were Sent Properly



Import File Format
Agent can import messages from a text file in the standard UNIX message format (RFC-822).    If you 
were using Eudora or Pegasus for email, Forté provides converters for exporting messages from these 
programs into the standard UNIX format.    For more information, see Importing Email Messages from 
Another Program.

As a convience to those not using Eudora or Pegasus, the following describes in some detail the standard
UNIX message format Agent can import:

· Each message must be preceded by a line of the form:
From <user>@<domain> <dow> <mon> <day> <hour>:<minute>:<second> <year>
Where:

<user>@<domain> is the email address of the sender of the message.    Agent actually ignores this 
address, so it can be any address.    For example, "???@???" is acceptable.

The rest of the line is the date of the message.    Agent requires that the date be in a legal format, but 
it ignores the date unless the message itself contains no Date: field.    The elements of the date are:

<dow> is one of: Sun, Mon, Tue, Wed, Thu, Fri, Sat (Agent ignores this).

<mon> is one of: Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep, Nov, Dec.
<day> is the day of the month.
<hour>:<minute>:<second> is the time of day in 24-hour time, for example 16:21:53.
<year> is the year.
Example From line:
From ???@??? Fri Sep 8 13:21:43 1995

· The message's header fields must follow immediately after the From line.    Each header field line 
must begin with the name of the field, without any preceding whitespace, followed by a colon and a 
space, followed by the value of the field.    For example:
To: mark.sidell@forteinc.com
A field value may be continued on subsequent lines.    Each continuation line must begin with at least 
one space character.    For example:
To: mark.sidell@forteinc.com,
   jon.berke@forteinc.com

· The header fields must be followed by a single blank line, followed by the body of the message.    The 
blank line should contain no space characters.

· If any line in the body is in the same format as the From line described above, it must be quoted with 
some other character, so that Agent does not think it is the beginning of the next message.    To quote 
the line, all that is required is that the word "From" not appear at the very beginning of the line.    By 
convention, these lines are quoted with '>'.    For example:
>From robin.mitchell Fri Sep 8 13:21:43 1995

Here's an example message:
From mark.sidell Fri Sep 8 13:21:43 1995
From: mark.sidell@forteinc.com
To: jon.berke@forteinc.com
Subject: Import file formats
Date: 21 Aug 1995 19:47:12 GMT

Jon, here is an example of a quoted From line.  The following line looks just 



like a From line that begins a message, so I have quoted it. 

>From robin.mitchell Fri Sep 8 13:21:43 1995
That's all for now! 



Build: 16 bit Agent:
NoFree:    No (Free Agent only topics)
YesMail:    Yes (Receive email topics)
YesFolders:    Yes (All aspects of folders)
YesSpelling:    Yes (Spell check topics)
YesSorting:    Yes (Sorting topics)
NoBit32:    No (Features only available in the 32bit version)



AGENT.INI
Click on the section name below to jump directly to that section.
[Article]
[Attachment]
[Browser]
[Colors]
[Confirm]
[Debugging]
[Directories] 
[Email] 
[FolderMenu]
[Groups] 
[Languages]
[Message]
[Online]
[Print]
[Profile]
[Purging]
[Servers] 
[Spelling]
[TimeZone]
[Timing]
[View]
;=====================================================================
[Profile]
FullName=
;Your full name as you want it to appear in your messages.
;You may leave this blank.

EMailAddress=
;Your email address.

ReplyTo=
;Where replies to your messages should be sent,
;if different from your email address.

Organization=
;Your organization.
;You may leave this blank.

DoAuthorization=0
;When non-zero, perform authorization login to news server.

SavePassword=1
;Save authorization password between sessions.

UserName=
;News server authorization username.

Password=
;News server authorization password (encrypted).

IsLicensed=1
;When non-zero, you have accepted the license agreement.

IsRegistered=1
;(Free Agent only) When non-zero, you registered Free Agent.
 
EnableSupportMenu=0
;System administrators for site-based copies of Agent can turn this
;parameter on to display the Post | Support Question menu option.



;=====================================================================
[Servers]
NewsServer=
;The name or IP address of your NNTP news server.

MailServer=
;The name or IP address of your SMTP mail server.

NNTPPort=119
;Winsock port to use for connecting to the NNTP news server.
;When this value is the standard news server port number (119), Agent
;first asks the winsock driver for the port number to use.  If that
;call (getservbyname) fails, Agent then tries to use this port number.
;When this value is *not* the standard news server port number, Agent
;uses it instead of the asking the winsock driver for the port number
;to use.

SMTPPort=25
;Winsock port to use for connecting to the SMTP mail server.
;When this value is the standard mail server port number (25), Agent
;first asks the winsock driver for the port number to use.  If that
;call (getservbyname) fails, Agent then tries to use this port number.
;When this value is *not* the standard mail server port number, Agent
;uses it instead of the asking the winsock driver for the port number
;to use.

PopServer=
;The name or IP address of your POP server.

POPPort=110
;The port to use for connecting to the POP server.
;When this value is the standard POP server port number (110), Agent
;first asks the winsock driver for the port number to use.  If that
;call (getservbyname) fails, Agent then tries to use this port number.
;When this value is *not* the standard mail server port number, Agent
;uses it instead of the asking the winsock driver for the port number
;to use.

SMTPServerPort=25
;The port to use for listening for inbound SMTP connections, used when
;receiving email via SMTP.  Default is 25.

;=====================================================================
[Groups]
LastUpdate=
;The most recent date and time at which the program retrieved a list
;of new Usenet groups, in GMT.  When the program retrieves a list of
;new groups, it asks for all groups created after this date.
;Setting this to blank forces the program to retrieve a list of all
;groups.

RefreshMode=1
;The number associated with the last option selected in the Refresh
;Group List dialog box.

LastFolderSelection=
;The name of the last folder selected with the Copy/Move messages
;dialog (All Folders menu option).

;=====================================================================
[Online]
AutoDisconnect=1
;Disconnect from news server after <NoActivityTimeout> seconds of
;inactivity.  Zero means never disconnect.

NoActivityTimeout=300



;Period of no activity after which the program should disconnect
;from the NNTP server (seconds).

MailAutoDisconnect=1
;Disconnect from POP mail server after <MailNoActivityTimeout> seconds
;of inactivity.  Zero means never disconnect.

MailNoActivityTimeout=5
;Period of no SMTP activity after which the program should disconnect
;from the SMTP server (seconds).

SendKeepAliveMsgs=1
;Send "keep alive" messages to the news server.
;This keeps the dial-up connection alive.

KeepAlivePeriod=60
;How often, in seconds, to send a keep alive message during periods of
;inactivity.

XHdrOnly=1
;When non-zero, use XHDR commands to request message header information
;from the news server, rather than XOVER.  Some servers do not support
;the newer XOVER command, which is faster than XHDR.  The program
;automatically detects whether the server recognizes XOVER and falls
;back to XHDR if it doesn't.  But, you can also use this option to
;force it to always use XHDR.

EnablePriorityTask=1
;When non-zero, enable priority tasks for retrieving message bodies.
;This allows the program to open two channels to the news server,
;with one reserved as a priority channel for retrieving messages.

AutoView=0
;What to do when you double-click on a message without a body
; 0 Retrieve the message's body
; 1 Mark the message for later retrieval
; 2 Retrieve the body if online, mark for retrieval if offline
; 3 Do nothing

RetryConnectAttempts=0
;How many times to retry connecting to the server after getting
;any of the following errors:
; - Connection refused (winsock error 10061)
; - Operation timed out (winsock error 10060)
; - 400 Service not available
;If the parameter is zero, Agent reports an error after the first
;attempt.

RetryConnectPause=30
;How long to wait, in seconds, between connection attempts when
;retrying.

RetryConnectCloseWinsock=0
;When non-zero, Agent closes winsock after each connection failure and
;reloads it before retrying.  If you are using a winsock dialer, this
;causes the dialer to hang up the modem between connection attempts.

UseGetHostName=0
;By default, Agent uses winsock function WSAAsyncGetHostByAddr() to
;obtain the name of the PC itself, for use when logging into SMTP
;servers.   Setting this option to non-zero causes Agent to use
;function gethostname() instead.  This option can be used as a
;workaround for winsock drivers that do not support
;WSAAsyncGetHostByAddr().

EnableMsgIdRetrieval=1
;When non-zero, if Agent fails to retrieve a Usenet message body by
;message number, it will attempt to retrieve it by message ID.  Some
;news servers are slow in responding to message ID requests, so you can
;set this option to zero to disable message ID retrieval.



ErrorTimeout=300
;The amount of time (in seconds) Agent waits after displaying the
;online error dialog box before going offline automatically.  Agent
;does not cancel any online tasks until you confirm that you want to do
;so on the dialog.  If you choose to resume processing, Agent will go
;online again.  This parameter applies only if auto-disconnect is
;enabled (AutoDisconnect=1).

;=====================================================================
[View]
AutoOpenMode=1
;Automatically maintain positioning in subsidiary browsers when
;the highlight in a browser changes.

ShowToolBar=1
;Display the toolbar at the top of the screen

ShowStatusBar=1
;Display the status bar at the bottom of the screen

StatusBarFont=MS Sans Serif, 80, 0, 0, 0,0,0
;Font used for text in the status bar.

InitialView=1
;Specifies the initial view for the Groups/Folders pane:
; 0 - All Groups
; 1 - Subscribed Groups
; 2 - New Groups
; 3 - Folders 

MainWindowPosition="0 1 -1 -1 -4 -4 86 57 875 677"
;Initial screen position of the program's main window

BrowserPosition="3 3 94 347 -4 -23 15 18 663 348"
;Initial screen position of the browser

ProgressStyle=0
;Controls the format of the graphical online task progress indicator
;which appears in Agent's Status Bar.  The options are:
;0 - Display the progress indicator in its own box on the Status Bar.
;1 - Display the progress indicator in its own box, and include text
;    showing the percentage of the task completed so far.
;2 - Display, in its own box, text showing the percentage of the task
;    completed so far without a graphical progress indicator.
;3 - Display the graphical progress indicator over the text describing
;    the current task.
;4 - Do not display the progress indicator.

ProgressDelay=1000
;How long to wait, in milliseconds, when the percent complete changes
;from 0 to a non-zero value, before updating the online task progress
;indicator display.  Once the delay threshold has been exceeded, Agent
;updates the display continuously.  This delay causes Agent to not
;display the progress indicator for extremely short operations, such as
;downloading short article bodies.

GroupPropTab=0
;The tab last displayed in the Properties for Selected Groups dialog
;box (Group menu).  The next time you open this dialog box, Agent will
;display this tab.

DefGroupProp=0
;The tab last displayed in the Default Properties for All Groups dialog
;box (Group menu).  The next time you open this dialog box, Agent will
;display this tab.

PrefsTab=0
;The tab last displayed in the Preferences dialog box (Options menu).
;The next time you open this dialog box, Agent will display this tab.



InboundTab=0
;The tab last displayed in the Inbound Email dialog box (Options menu).
;The next time you open this dialog box, Agent will display this tab.

;=====================================================================
[Browser]
NormalFont=Arial, 80, 0,0, 0,0,0
;Font for normal items
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

BoldFont=MS Sans Serif, 80, 1,0, 0,0,0
;Font for special items( e.g. first message in thread)
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

ScrollMargin=2
;The minimum number of lines to maintain above and below the
;highlighted item when scrolling with the cursor keys.  This keeps the
;highlight from getting pinned at either the top or bottom screen rows.

FollowUpIndent=4
;Amount to indent follow-up messages in the Message List pane,
;in characters.

MaxNestLevel=6
;The maximum indentation level for response messages in the message
;list browser.  The absolute maximum level allowed is 15.

CollapseThreads=1
;Initially collapse threads in the Message List pane.

ExpandNewThread=1
;When positioning on a new message, automatically expand the thread
;if the message is a follow-up and if the first message in the thread
;has been retrieved.

SubjectThreading=1
;Use subjects to combine messages into threads, in addition to message
;references.

ArticleListColumns=147,745
;Offsets of the left edges of the columns in the Message List pane,
;in units of 10x the average character width.
;The edge of the left-most column is always 0, so is not included here.

OutBoxColumns=87,432,697
;Offsets of the left edges of the columns in the Outbox browser,
;in units of 10x the average character width.
;The edge of the left-most column is always 0, so is not included here.

NewSubjectStartsNewThread=1
;When set, a follow-up message that contains a different subject than
;its referenced message starts a new thread.  When this option is not
;set, Agent includes the follow-up in its referenced message's thread.

WatchSkipsToNextUnread=1
;When this option is on (the default), watching an unread message
;causes Agent to skip to the next unread message.

SortDateDescending=0
;When non-zero, do date sorts descending.  Default is zero (ascending).

SortSizeDescending=0
;When non-zero, do size sorts descending.  Default is zero (ascending).

;=====================================================================
[Article]
VariableFont=MS Sans Serif, 100, 0,0, 0,0,0
;Variable-pitch font for the message body viewer
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>



FixedFont=Courier, 100, 0,0, 0,0,0
;Fixed-pitch font for the message body viewer
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

UseFixedFont=1
;Use the fixed-pitch font for messages

WordWrap=1
;Word wrap messages

ShowHeader=1
;Show all header fields in messages

QuotedTextMarkers=>:|}
;The characters that mark a quoted line of text in a message.
;If a line begins with any of these characters, it is assumed to be
;quoted.

URLPattern=[a-zA-Z]+:/[^ \t\r\n>)\]"']*[a-zA-Z0-9/]
;A regular expression defining the pattern for URLs

TabSpacing=3
;Tab spacing for messages.

SaveArticleFields=2
;Controls which header fields to save when writing a message to a text
;file.  Options are:
;0 - No fields
;1 - Subject, author, and date only
;2 - All fields

SaveArticleAppend=1
;If the file to which a message being saved already exists, append to
;it.  Otherwise, overwrite the file after prompting for verification.

PageDownMode=0
;Controls the behavior of the PageDown key in the Message pane.
;When the option is non-zero, Agent will not page down if the last
;line of the message is visible.  The default setting is zero.

ShowFullAddress=0
;When non-zero, show the full email address of the author in the
;Message pane and header.

NewsBaseFields=
NewsAllFields=
MailBaseFields=!to,!subject,!from,!date,cc,bcc
MailAllFields=
;These params control which header fields are displayed at the top of
;the message body.  The News* params control usenet messages, and the
;Mail* params control email messages.  The *Base* params control the
;fields that are displayed when option Show Header Fields is off, and
;the *All* params control the fields that are displayed when the option
;is on.  Each param may contain a list of comma-separated field names.
;The fields are displayed in the order listed.  If a field name is
;preceded with a !, then the field is always displayed.  Otherwise, the
;field is displayed only if it is actually contained in the message.
;If a *Base* param is empty, then no fields are displayed when Show
;Header Fields is off.  If an *All* param is empty, then all fields are
;displayed when Show Header Fields is on.

SaveArticleFormat=0
;Controls formatting of the text file when saving messages.
;0 - UNIX message file format
;1 - include a separator line before each message
;2 - no separators before messages

SaveArticleSeparator="========\n"
;The separator to be used when SaveArticleFormat=1.



SaveArticleFields=1
;Which header fields to include when saving messages to files.
;0 - no header fields (body only)
;1 - selected header fields
;2 - all header fields

SaveArticleFieldList="To,Subject,From,Date,Cc,Bcc"
;A comma-separated list of fields to be included in saved messages when
;SaveArticleFields=1.  Agent includes a field only if it is actually
;defined in the message.

ImportUseXFolder=1
;When non-zero, if a message being imported begins with a X-Folder
;field, place the message in the specified folder.

ImportFileMode=0
;Controls how Agent decides where to place imported messages.  If
;ImportUseXFolder=1, any X-Folder field in a message overrides this
;setting.
;0 - Use Agent's Filing filters to file messages based on content
;1 - File all messages in the folder specified by ImportFileFolder.

ImportFileFolder=
;Specifies the name of the folder to be used when ImportFileMode=1.

;=====================================================================
[Attachment]
PartitionMode=1
;Controls how attachment messages are partitioned:
; 0 = Partition into messages (AttachmentPartitionSize controls size)
; 1 = Do not partition (send as a single message)

PartitionLines=900
;When attachment messages are partitioned, the maximum number of lines
;of data to send per message.  Each line contains 45 bytes of data,
;and consists of 63 characters.

TextMode=0
;Controls if and how text is sent with attachments
; 0 Send text as separate preface message
; 1 Include text at beginning of first partition message
; 2 Send no text

FileMode=644
;UNIX file mode for attachment files.  This is a string.
;This is the mode that is included at the top of the uuencoded file.

;=====================================================================
[Purging]
;The parameters in this section can be modified within Agent from the
;What to Purge tab on the Default Group Properties dialog box and the
;When to Purge tab on the Default Group Properties dialog box.

PurgeByNumber=1
;This option controls how Agent's purge operation determines whether
;a message is no longer available.
; 0 = Purge based on message range reported by the server.
; 1 = Always download headers and purge based on those.

PurgeOnNewHeaders=1
;Purge messages when getting new headers.

PurgeOnExit=1
;Purge messages when exiting Agent.

CompressOnPurge=0
;When non-zero, selecting a Purge Messages option from the Group menu
;also compacts the databases being purged.  Note: A database is
;compacted only when the percent of disk space saved is greater than
;the value of the CompressPercent parameter.



CompressOnExit=0
;When non-zero, Agent will compact all your databases when it closes. 
;Note: A database is compacted only when the percent of disk space
;saved is greater than the value entered in the "Compact only if
;wasted space at least..." field below.

CompressPercent=20
;Before compacting a database, Agent checks to see how much disk
;space would be saved by the compact operation.  This setting allows
;you to bypass the operation if only a small amount of disk space
;would be saved.  Enter the minimum amount of disk space savings, as a
;percentage of the total size of the database, that will cause Agent
;to perform an automatic compaction after either a manual purge
;and/or an automatic purge during exit.

ConfirmPurgeOnExit=1
;When this option is non-zero, Agent asks for confirmation before
;purging and/or compacting databases when you close the program. 
;When this option is zero, the Agent will purge and/or compact the
;databases without asking first.  Note: To purge or compact databases
;on exit, be sure to enable PurgeOnExit and/or CompressOnExit.

AlwaysPurgeUnavailable=1
;When this option is on (the default), and you have selected one of
;the "When the message is no longer available" purge options, Agent
;will always purge messages that are no longer available during get
;new headers, even if you have turned off the "Purge when retrieving
;new headers" option.  This parameter cannot be set within Agent.

;=====================================================================
[Message]
UseFixedFont=1
;Use the fixed-pitch font for outgoing messages

WordWrap=1
;Word wrap outgoing messages in the display window

IncludeOriginalText=1
;Automatically include the text of the original message when creating
;a follow-up message or email reply.

QuotePrefix="> "
;String used to quote text from the original message when creating
;a follow-up message or email reply.

FollowupString="%from% wrote:\n"
;The string used to generate the first line(s) of a follow-up message.
;This value should be defined directly from Agent.  For more
;information, see Composing an Introduction String.
;If the string is blank, no first line is generated.
;
;Text enclosed in %...% are the names of fields from the original
;message.  Two %% represent a single % literal.
;
;In addition to the standard message fields, the program supports these
;special fields:
; %Full-Name% Full name of author
;
;You may also use the following escape sequences:
; \n newline
; \t tab
; \\ the backslash character itself

ForwardString="In %newsgroups%, %from% wrote:\n"
;The string used to generate the first line(s) of a forwarded Usenet
;message. If the string is blank, no first line is generated.
;Uses the same formatting commands as FollowupString.

MailReplyString="On %date%, you wrote:\n"



;The string used to generate the first line(s) of an email reply.
;If the string is blank, no first line is generated.
;Uses the same formatting commands as FollowupString.

MailReplyMailString="On %date%, you wrote:\n"
;The introduction string for email replies to email messages.
;If the string is blank, no first line is generated.
;Uses the same formatting commands as FollowupString.

ForwardMailString="On %date%, %from% wrote:\n"
;The introduction string for forwarded email messages.
;If the string is blank, no first line is generated.
;Uses the same formatting commands as FollowupString.

LineLength=70
;The maximum line length for outgoing messages.
;The program word-wraps longer lines.
;Setting this to zero disables word-wrap in outgoing messages.

SaveSentMessages=1
;Save messages that have been successfully posted in the outbox.

SendTagLine=0
;(Free Agent Only) When non-zero, the Free Agent advertisement tag line
;is included at the bottom of messages.

GMTDates=1
;When non-zero, post all messages and emails in GMT format as opposed
;to your local timezone.

CurrentGroupOnly=1
;This option controls which newsgroups are included by default for
;follow-up posts.  If the referenced message includes a Followup-To
;field, Agent always lists the groups from that field, independent of
;this option.  If the referenced message does not contain a Followup-To
;field, and this option is set, Agent includes just the name of the
;group that was selected when the follow-up message was created.  If
;this option is not set (the default), Agent includes all groups listed
;in the referenced message's Newsgroups field.

ValidateAddresses=1
;When non-zero, Agent tries to validate all email address fields (To:,
;Cc:, Bcc:, From:, Reply-to:, and Sender:) in messages that you send. 
;Set this value to zero if you need to enter non-standard addresses.

ShowAllFields=0
;When non-zero, Agent allows editing of the Control and Approved
;message fields.

GenerateID=1
;When non-zero, Agent generates Message IDs when posting messages.

;=====================================================================
[Directories]
Attachments="C:\AGENT\, *.txt, 0"
;The last directory selected in the Attach Binary File dialog box.
;The third parameter is the listbox index of the file-type filter
;(e.g.,"*.TXT") that was last selected in the dialog box.

Files="C:\AGENT\, *.txt, 1"
;The last directory selected in the Save Messages As and the Import
;Messages dialog boxes.
;The third parameter is the listbox index of the file-type filter
;(e.g.,"*.TXT") that was last selected in the dialog box.

Signatures="C:\AGENT\, *.txt, 1"
;The last directory selected in the Select Signature File dialog box.
;The third parameter is the listbox index of the file-type filter
;(e.g.,"*.TXT") that was last selected in that dialog box.



Home=
;The directory where Agent's database files and custom dictionaries are
;stored.  If this parameter's value is blank (the default), Agent looks
;for these files in the directory containing AGENT.INI.  Note: Changing
;this setting does not move your files.  Use File Manager to move all
;the files (*.IDX, *.DAT, and CUST*.TLX) to the new location and then
;restart Agent for this change to take effect.

Shared=
;The directory where Agent's help file and master dictionaries are
;stored.

WAVFiles=
;The last directory selected in the Select WAV File dialog box. 

;=====================================================================
[Colors]
BrowserNormalColor=0,0,0
;Color for normal messages
;<red>,<green>,<blue>

BrowserUnreadColor=128,0,0
;Color for unread messages.
;<red>,<green>,<blue>

BrowserSelectedUnreadColor=255,255,0
;Color for unread messages that are selected (highlighted).
;Normally, this should be the inverse of the Control Panel's highlight
;color.
;<red>,<green>,<blue>

ArticleNormalColor=0,0,0
;The color for normal text in messages.

ArticleQuotedColor=0,0,255
;The color for quoted text in messages.
;A line is quoted if it begins with one of the QuotedTextMarkers.

;=====================================================================
[Confirm]
DeleteGroup=1
;Confirm group deletions

StopTasks=1
;Confirm actions that would cancel active online tasks

DeleteArticle=1
;Confirm message deletions

DeleteOpenMessage=1
;Confirm closing message composition window if the user has modified
;the message

DeleteOutboxMessage=1
;Confirm message deletions in the outbox

CloseWithTasks=1
;Confirm program close when tasks are running

DefaultAction=0
;Default key in confirmation dialogs, 0=NO, 1=YES

MarkAllRead=1
;Confirm the Mark All Messages Unread and Mark All Messages Read
;commands.

LaunchEXE=1
;Confirm the launching of executable attachments.



FollowupPoster=1
;When non-zero, display an informational message box if you post a
;followup message to a message for which the poster has requested that
;followups be sent via email.

;=====================================================================
[TimeZone]
AssumeLocal=1
;If a downloaded message does not specify a timezone in its Date field,
;assume local time.  When this option is not set, Agent assumes GMT.

MinutesFromGMT=-480
;The local timezone, in minutes from GMT.
;If ObserveDST is true, this should be the offset for standard time.

ObserveDST=1
;Automatically adjust the timezone offset to account for DST
;between April and October.

TimeZoneName=5
;A number that uniquely identifies the timezone name as selected on
;the Preferences | System Profile dialog box, used to identify the
;particular name selected for zones with multiple choices.

;=====================================================================
[Print]
LeftMargin=75
TopMargin=75
RightMargin=75
BottomMargin=75
;Margins for printing, in 1/100 inch increments.

Fields=1
;Header fields to include in printed messages
; 0 No fields
; 1 Subject, author, and date only
; 2 All fields

PageBreaks=0
;Where to put page breaks
; 0 None
; 1 Between messages
; 2 Between threads

Font=Times New Roman, 100, 0,0, 0,0,0
;Printer font

;=====================================================================
[Email]
Mode=<n>
;0=Receive email with SMTP
;1=Receive email with POP

POPAccount=
;POP account name.

SavePOPPassword=0
;When non-zero, save the POP password between sessions.

POPPassword=
;The saved POP password.

AlertBox=1
;When non-zero, display a message box when new mail arrives.

AlertSound=1
;When non-zero play a sound when new mail arrives.



AlertSoundFile=
;The name of the WAV file to play for the email alert sound.  This may
;also be the name of a sound listed in the WIN.INI [Sounds] section.
;If this is blank, Agent simply beeps.

AutoCheck=1
;When non-zero, automatically check for email periodically.

AutoCheckPeriod=0
;How often to check for email, in minutes.

LeaveOnServer=0
;When non-zero, leave email on the POP server after retrieving it.

SkipLong=0
;When non-zero, skip long email messages.

SkipLongKBytes=64
;The messages size threshold (in kilobytes) for SkipLong.

SkipLongLines=20
;How many body lines to retrieve for messages being skipped.

MaxSMTPSessions=2
;How many clients Agent will allow to connect simultaneously when
;receiving email with SMTP.

SMTPSessionTimeout=300
;How many seconds of inactivity to allow on an SMTP receive email
;session before cancelling and closing the session.

AutoDecode=1
;When non-zero, auto-decode email message attachments while retrieving
;the messages.

AutoDecodeDirectory=
;The destination directory for auto-decoded email attachments.

SMTPAlways=0
;When non-zero, and you are configured to receive email with SMTP, load
;winsock immediately on program startup and start the SMTP task.

AutoCheckMode=0
;0 - Automatically check for email only when online for some other
;    reason.
;1 - Automatically check for email at all times, and unload winsock
;    between checks.
;2 - Automatically check for email at all times, but leave winsock
;    loaded between checks.

;=====================================================================
[Spelling]
;This section is not available in Free Agent.

AlwaysSuggest=1
;When non-zero, the spell checker will automatically suggest possible
;replacement words.

CheckRepeatedWords=1
;When non-zero, the spell checker will stop when it finds the same word
;twice in a row.

IgnoreNumeric=1
;When non-zero, the spell checker will ignore words containing numbers.

IgnoreUpperCase=1
;When non-zero, the spell checker will ignore words composed of all
;uppercase letters. 

IgnoreQuotedLines=1



;When non-zero (the default), the spell checker will ignore words which
;appear on lines beginning with a quote character (as defined by the
;Quoted Text setting on the Preferences dialog box's Display tab).

;=====================================================================
[Timing]
GetHostByNameTimeout=30
;Timeout period for looking up the host's name (seconds)

ConnectTimeout=10
;Timeout period for connecting to host (seconds)

ResponseTimeout=120
;Timeout period for waiting for a response from the host (seconds)

SendTimeout=60
;Timeout period for sending a command to the server (seconds).
;This is the maximum time the program will wait during a blocked
;transmission, not the total time allowed to send a message.

PostTimeout=60
;Timeout period for posting a message or email message (seconds).
;This is the maximum time the program will wait during a blocked
;transmission, not the total time allowed to send a message.

SplashTime=5
;Minimum time to display the splash screen (seconds)

PostResponseTimeout=360
;How long, in seconds, Agent will wait for an acknowledgment from the
;server after posting a message or email message.

SMTPSessionTimeout=300
;How many seconds of inactivity to allow on an SMTP receive email
;session before cancelling and closing the session.

;=====================================================================
[Debugging]
ShowUID=0
;When non-zero, Agent shows the group/folder UIDS in the Groups/Folders
;pane.  This number is the base filename for each group's IDX and DAT
;files.

VerboseLog=0
;When non-zero, include extra information in the log window, including
;a script of Agent's conversation with the news server, and task state
;machine transitions.

FileLog=0
;When non-zero, Agent writes log output to AGENT.LOG.  The contents of
;this file are erased at the start of each Agent session.

TraceLog=0
;When non-zero, send log output to the Windows debugging console, so
;that it appears in programs like DBWIN.

TraceHelp=0
;When non-zero, send a debugging statement to the Windows debugging
;console each time Agent sends a request for online help.

ShowArticleDetail=0
;When non-zero, show some detailed information about messages at the
;bottom of the Message pane.  In particular, this shows the message's
;number as reported by the news server.

ShowMemUsage=0
;When non-zero, show the total number of allocated blocks in the status
;bar.  This option is used to check for memory leaks.



EnableTrace=0
;When non-zero, enable debugging trace statements to be sent to the
;Windows debugging port.

WinsockLog=0
;When non-zero, all winsock calls are written to AGENT.LOG.

EnableMenu=0
;When non-zero, Agent displays the debugging menu options.  You can
;also toggle the display of the debug options by pressing Ctrl+Shift+D
;in Agent.

ShowBuild=0
;When non-zero, Agent displays the build number in the title bar and
;About dialog box.

ShowInternalFields=0
;When non-zero, Agent displays its internal fields in the Body pane.

;=====================================================================
[Languages]
;This section is not available in Free Agent.

;This section is not included in AGENT.INI by default.  You can add it
;if you want to customize the spell checker's dictionaries, however.
;Each parameter in this section has the following format:
;<id>=<name>,<apostrophe-flag>,<custom>,<master1>[,...<masterN>]
;
;<id> is a three-letter language ID, which uses the same convention as
;WIN.INI.  Here are the current ids:
; enu English (American)
; eng English (International)
; frn French
; ger German
; itn Italian
; spn Spanish
;
;<name> is the name of the language as displayed in Agent.
;
;<apostrophe-flag> is a 0/1 flag indicating whether apostrophe should
;be considered a word separator.  When this flag is true (1), if a word
;containing embedded apostrophes is not found in any dictionary, Agent
;treats the apostrophe as a word separator and checks each sub-word
;individually.  Normally, this flag is set only for French, in which it
;is common to create new words by combining words with apostrophe.
;
;<custom> is the name of the custom dictionary.   By convention, this
;file is named CUST<id>.TLX.  If the filename has no path, Agent looks
;for the file in the Home directory.  If the file does not exist, Agent
;creates it.
;
;<master> is the name of one or more master dictionaries.  You can list
;up to 12 files.  When checking words, Agent searches the dictionaries
;in the order listed.  By convention, the common words file is named
;MAIN<id>.TLX and the compressed words file is named MAIN<id>.CLX.  If
;the filename has no path, Agent looks for the file in the shared
;directory.  If none of the master dictionaries for a given language
;exist, Agent assumes that the language is unavailable, and removes it
;from the list of available languages in the UI.
;=====================================================================
[FolderMenu]
Menu1=
...
MenuN=
;A list of the folders that appear on the Copy/Move to Folder flyouts. 
;The names of options (Menu1, etc.) don't matter.  Agent simply uses
;the first none items from the list to populate the flyouts.



Build: 16 bit Agent:
NoFree:    No (Free Agent only topics)
YesMail:    Yes (Receive email topics)
YesFolders:    Yes (All aspects of folders)
YesSpelling:    Yes (Spell check topics)
YesSorting:    Yes (Sorting topics)
NoBit32:    No (Features only available in the 32bit version)



Release Notes
This topic describes the features most recently added to Agent.    For a more comprehensive set of 
release notes, please check our Web pages (http://www.forteinc.com/forte/).
Version 1.00
Improved the Purging option to give you more control over which articles are purged.    Also, you can now 
purge groups manually, and automatically on program exit.    For details, see the Purging tab of the 
Properties for Selected Group dialog box.

Added an option to compact the databases.    To compact your databases, choose Compact Databases 
from the File menu.

Significantly improved download, threading, and purging performance.    Now, purging most groups should
only take a few seconds at most.

You can now send an email carbon copy (CC) when you post an article.    This is especially useful when 
you want to post a follow-up response and email the original author at the same time.    For more 
information, see Compose Article window.

Moved some commands from the File menu to a new Options menu and the Window menu.    Commands
that control program configuration are now on the Options menu.    Commands that open new windows 
are now on the Window menu.

Agent now allows you to edit all header fields (Distribution, Keywords, etc.) for messages you send.    For 
more information, see Compose Article window and Compose Email window.

You can now mark an article unread while you are viewing its body.

Selecting Watch Thread on an unread    article now skips to the next unread article.    You can disable this 
option with the Navigation tab of the Preferences dialog box..

You can now control whether or not Agent should validate email addresses in your messages.    For 
details, see the Message Posting tab of the Preferences dialog box.

You can now cancel a post after you send it.    To cancel a post, highlight the article in the Article pane and
choose Cancel Article from the Article menu.

Agent now accepts a command line parameter to specify the location of AGENT.INI.    E.g., agent 
<path>.    The optional <path> argument can be either the directory containing AGENT.INI or the name of
the INI file to use as AGENT.INI.

· If no <path> is specified, Agent looks for AGENT.INI in the current working directory.    If the file 
doesn't exist, Agent creates it.

· If <path> is a filename, Agent uses that file as AGENT.INI.    If the file doesn't exist, Agent creates it.
· If <path> is a directory, Agent looks for AGENT.INI in the specified directory.    If the file doesn't exist, 

Agent creates it.    Note: If the directory doesn't exist, Agent assumes that you are specifying a 
filename.    You can prevent this from happening by appending a \ to the end of the directory name to 
force Agent to always treat it as a directory.      For example: c:\agent\.

Added support for Spry's winsock dialer.    This fixes problems using Agent with Internet in a Box and 
CompuServe.    You no longer have to manually start the Spry dialer prior to having Agent go online.

Agent is now less strict when searching for the articles composing a binary attachment.    It ignores case 
and leading/trailing whitespace when comparing the article subjects.

Added "Delete Body" to the Article menu.    Select this option to delete the selected article's body but not 
its header.

Add drag-select support to highlight multiple groups or articles with the mouse.    Just click and drag the 
mouse over the groups or articles.

Agent now starts a new thread when a follow-up article has a different subject than the original.    You can 
control this behavior with the Navigation tab on the Preferences dialog box.



Agent's dialog boxes now have the correct 3D look when running in Windows 95.

After unsubscribing to a group or leaving a group you just sampled, Agent now asks if you want to keep 
the group's articles.    If you say "No," it will immediately delete articles in the group.    This feature helps 
you delete unwanted database files from your disk.

Agent now includes all newsgroups from the original article when you post a follow-up to a cross-posted 
article.    This option is controlled by an AGENT.INI parameter: 

[Message]
CurrentGroupOnly=0

Added a confirmation message when you mark all the articles in group as read or unread.    You can turn 
this message off from the Confirmations tab of the Preferences dialog box.

Agent can now retry refused connections that can occur when the news server is very busy.    For details, 
see the Online Operation tab of the Preferences dialog box.

Added context menus to the Composition and Outbox windows.    Context menus are activated by clicking
the right mouse button.

Add a preference option for selecting which mouse button selects items from the context menu.    See the 
Navigation tab of the Preferences dialog box for details.

Skipping to the next unread article from the Group pane now moves the focus to the Article pane for the 
next group with an unread article and selects that article.    You can disable this behavior by unchecking 
the "Skipping to next unread article jumps..." box on the Navigation tab of the Preferences dialog box.

Agent now adds a leading zero when posting multi-part attachments.    E.g., [04/15].

When an article does not contain a timezone, Agent now assumes local time.    It used to assume GMT.    
This feature is controllable via an AGENT.INI parameter:

[TimeZone]
AssumeLocal=1

Choosing Get Selected Article Bodies when a collapsed thread is selected now retrieves the bodies of all 
the articles in the thread.

You can now specify a location for your database files (*.IDX and *.DAT).    To keep your database files in 
a directory other than Agent's normal working directory, edit the Home parameter in the [Directories] 
section of AGENT.INI.

Ctrl+A now works in the Outbox window.

Added an option to AGENT.INI to override the Port numbers used for the NNTP and SMTP servers.    
See AGENT.INI for details.

Agent now deletes the Outbox files when all the messages in the outbox are deleted.

Agent now strips EOF characters from signatures when posting.

The various debugging parameters are now documented in the AGENT.INI help topic.

Agent now purges all but the most recent article in an ignored thread.

Agent now detects when the news server renumbered the articles in a group.    When this occurs. Agent 
adjusts the high article numbers accordingly and retrieves all new articles.



Release Notes
Version .99c
You can now copy or move items from the Outbox to a folder.

You can now select a folder in which to automatically route your outbound messages.

Implemented an interim solution to binary decoding.    Agent now lets you apply all of the attachment 
decoding options to email messages in folders.    But, it never deletes the body of an email message.    
This means that it doesn't store the destination filename in the message after you have extracted the file, 
nor does it display the little camera icon next to the message.    The next release will have the fully 
integrated solution, with MIME support.

The email filter now recognizes the "Apparently-To:" field. If a received or imported email message 
contains an Apparently-To field rather than a To field, Agent treats the field as if it were the To field.

Added a Table of Contents to the AGENT.INI help topic.

Agent now generates its own message IDs when posting messages.    This was done so that sent 
messages, when copied from the outbox to a folder, will thread correctly with replies to the sent 
messages.    You can disable this feature (if Agent's message IDs disagree with your news server) with 
the following INI option:

[Message]
GenerateId=0

You can now cancel a sent Usenet message that has been placed in a folder if you allow Agent to 
generate message ids (the new default).    This will allow you to cancel a message without first retrieving it
from the news server.    If Agent does not generate the message id for the message, you must retrieve it 
from the news server before you can cancel it.

Added a Cancel button to the "Skip to Next Unread Group" message box.

After spell-checking a selected area of text, Agent no longer asks you if you want to start at the beginning 
of the message and spell check the entire message.

You can now selectively specify the header fields to use when printing.

Changed the way the progress bar works.    Hopefully, there's a setting to make everyone happy.    It is 
currently controlled by two INI options.    Click here for details.

Agent now accepts email messages of the form @x:foo@bar    (they're called "source routing 
addresses"), either with or without the enclosing <...>, and will pass the @x routing info to the mail server. 
The full syntax of the routing (@x:) portion of the address is:

@<domain> [,@<domain>]*:
(This means that the routing info consists of one or more @<domain> components, separated by 
commas, with the whole thing followed by a colon).

Enhanced the behavior when replying to a Usenet message which has the "Reply-To:" field set to 
"poster".    Agent now pops up a dialog which gives you the choice of (1) replying to the poster via email, 
(2) posting a Usenet message AND CCing the poster via email, or (3) just posting a Usenet message.

Agent now accepts email addresses without the "@domain" part.    Addresses with just the @ are also 
acceptable.    Agent does not try to determine the actual domain for the address.    Rather, it sends the 
address as is to the mail server, and lets it deal with it.    Most mail servers automatically assume the 
server's local domain if no domain is supplied.

Agent now supports the "In-Reply-To:" field (which identifies the specific message to which the reply 
pertains).

The build number now includes a "32" or "16" to indicate whether you are using the 32-bit or 16-bit 
version of Agent.

Under Preferences->Posting, Agent was limiting the length of the "Reply to Email" and "Forwarded Email"
introduction strings to the number of characters that fit on the screen.    This limit has been removed.



Agent now recognizes "UTC" when parsing the date/times of messages.

Agent now displays a warning message if you attempt to use "Save As" on a header with no body text.

When renaming a folder, the "new name" field automatically defaults to the old name to make it easier to 
edit.

Added end-of-message marker in the message body pane.

Agent now allows you to select text in read-only windows (i.e., in the message body pane) with the 
keyboard.    Previously, you could only use the mouse to select text.    To select text with the keyboard, 
turn off Scroll Lock on your keyboard.

Agent no longer spell-checks words that look like email addresses, domain names, URLs, etc.      
Normally, this means that Agent will not try to spellcheck the introduction line, unless an email address 
contains a proper name.

Various bug-fixes and enhancements in the composition window, including:
· Removed the 60K size restriction in composition and message window.
· Fixed a bug that could make Agent could hang while word-wrapping very long article that contained 

no hard carriage returns. 
· Some performance improvements
· Added end-of-message marker in composition window
· Fixed a bug in the function that calculates the space consumed by tabs, which is used to determine 

when to wrap lines in messages being formatted for transmission.    Also fixed problem that caused 
text to be wrapped incorrectly when displaying messages. 

· Fixed a GPF that could occur if you entered a very long field value in the "Value for:" edit control on 
the composition window. 

Agent now remembers an article's original newsgroup.    This allows Agent to use the correct Group 
Properties, Introduction Strings, etc. when you reply to a message from a folder.    For messages created 
outside the context of a group (original email messages and usenet messages created when no group is 
selected), Agent sets the field to blank, which will cause it to use the default group properties for the 
message.

Added the Post->New Copy of Message command.    This will allow you to resend a message that has 
been copied to a folder.

When opening any of the tabbed dialogs (e.g., Preferences, Properties for Selected Group), Agent now 
automatically selects the tab you were viewing the last time you had the dialog open.

Added the "Newsgroups:" header field on CCed copies of Usenet posts (so that when you get a copy of 
the email you get an indication in the header fields of what group it was associated with).

Fixed a problem which could cause a menu to be dismissed when the New Email Notification message 
was displayed.

Fixed a problem in the composition window which could cause text to be garbled or disappear after 
pasting text that came from a UNIX machine (UNIX machines use a single \n character as a line 
terminator instead of \r\n pairs).

Fixed a problem which could prevent you from copying or moving a message into a folder because Agent 
would think you had already copied/moved it.    Agent now does a better job of checking for duplicates, 
and also lets you override the warning and copy the messages anyway.

Fixed a problem which prevented Agent from accepting some less common format for email addresses.

Fixed a problem in which Agent was stopping all online tasks even if you answered "No" to the "Stop all 
online tasks?" prompt.

Fixed a problem which caused the current thread to collapse when new email was received.

Fixed a problem which caused a "435 Duplicate" error when posting multi-part Usenet messages.

Fixed a problem which could cause Agent to retrieve two copies of an email message if you had "Leave 



on server" enabled.

Fixed a problem in which the 'Newsgroup:' header field was not being initialized correctly when displaying 
messages in a folder.

The X-Attachment field is now visible when displaying all header fields for an email message.    This field 
contains the name of any attached file.

Fixed some problems in controlling the scroll lock light.    Now Agent maintains its internal state and its 
own scroll indicator, but does not enable/disable the keyboard scroll lock light.

Bullet-proofed against date/time calculation errors.

Fixed a GPF that occurred when trying to repaint an empty Body pane (after an operation such as 
resizing, scrolling, pressing a key, clicking in empty window).

Fixed a problem that prevented a right-mouse click from changing the window focus.    This occurred 
when you had two Newsgroup windows open and switched between them by clicking with the right-
mouse button.

Fixed a problem that could lead to an "out of memory" error when deleting messages.    This generally 
occurred if you pressed Delete in an empty message list.

Fixed a GPF that could occur if you defined a folder before you got groups for the first time and then gott 
new or refreshed the group list.

Fixed a GPF that could occur if you received an email with no header fields.

Fixed a GPF that could occur when you dragged and dropped a message with a long subject field.

Fixed two problems that could cause Agent to "unlock" articles when upgrading to Agent 99a or 99b from 
early version of Free Agent.

Fixed a problem in the French spell-checker.    It didn't deal with words that contained apostrophes.

Fixed a problem which could prevent Agent from retrieving all parts of an email message.    Apparently, 
some listservers send multiple messages with the same message id.    Agent would see the "duplicate" ID,
and assume that it had already retrieved the message.

Fixed a GPF that could occur if Agent checked for email while purging.

Fixed a problem in which active retrieval tasks could be disrupted if you changed the sort in a group that 
had any messages queued for retrieval.    This resulted in Agent not retrieving all marked message 
bodies.

Fixed a problem that could result in "error 550: User Unknown" when sending an email message.    This 
occurred if you had your field defaults set to always CC: yourself, and then you overrode that for an 
individual email by blanking the CC: field in the outgoing post.

Fixed a problem that was allowing email recipients to see who was BCCed on the email.    Agent now 
omits the Bcc field from the message when it is sent.

Fixed a problem that caused an Ignored thread to be marked "unread" if it was moved to a folder.

Fixed a problem that could cause Agent to hang or GPF if it read a message header which contained a 
References field with contained the message's own message id.    (We found another newsreader that 
incorrectly generated messages with this problem.)

Fixed a problem which could make new text wrap incorrectly in the composition with if you included one of
your quote characters (i.e. >) in the newly typed text.

Fixed a problem that was causing Agent to access the hard drive every second or so.    This problem only 
occurred if you were not running a disk cache program, such as SmartDrive.

Fixed a problem when Agent couldn't find the "Inbox" folder if the folder name started with a blank.

Fixed a problem which could cause a GPF @ 0001:4F93 or cause Agent to hang when merging in new 



headers.    These cases were due to messages that had a Reference: field that contained references to 
themselves.

Fixed error that could cause "503 need RCPT posting email" error message.

Fixed a problem that could cause the body pane to reset to the top when you    received new email or 
pressed a key that changed the state of the article (i.e. Keep, Ignore).

Fixed problem in spell-checker that could cause it to jump over a misspelled word (after deleting a 
previous word).

The menus have been changed to follow the new MS guidelines for using menu elipses.

Agent was sometimes using the wrong icon for incoming email messages, marking them as Usenet 
messages.    This has been fixed.

Fixed a problem that could cause Agent to hang reading an email with a long "To:" list.

Version .99b
Fixed a problem that would cause messages to be deleted when canceling a Move to Folder operation.

Fixed the "Error reported by server: -ERR bad number 0" problem when checking for new email.    This 
would occur if you told Agent to leave your mail on the server AND your server does not support UIDL.

Fixed two problems that only affected users who receive email via SMTP:

· GPF at 0001:1C4F that occurred when starting Agent.
· Agent was loading winsock on startup regardless of whether the "load on startup" option was 

checked.

Fixed GPF @ 0014:F9C7 which occurred if the data and/or shared directories specified in AGENT.INI no 
longer existed.

Fixed a Skip to Next Unread problem when viewing a sorted group.    If you changed the sort for a group, 
but Agent hadn't actually re-sorted the group (it was part of a multiple selection), and you performed a 
skip to next unread that jumped into that group, Agent jumped to the first unread message in the old sort 
and then re-sorted.    The result is that you ended up in a random location in the message list.

Fixed a bug which causes the Watch and Ignore flags to not propagate correctly if you selected Watch or 
Ignore while the Message list was sorted by anything other than Thread.

Version .99a
Due to email's tight integration, we've made a minor yet pervasive change to our terminology.    We've 
replaced the word "Article" with "Message."

User-defined folders have been added.    Folders appear in the Group pane (which is now called the 
Groups/Folder pane) along with newsgroups.    The commands for adding, removing, and showing folders
appear on the Group menu.    You can drag and drop messages into folders or use the Copy/Move to 
Folder options on the Message menu.    To have a folder appear on your Copy/Move to Folder flyouts, 
choose Manage Folder Menus from the Options menu.

You can now sort messages.    To sort the messages in a group or folder, choose the desired sort from the
Group menu or simply click on the column label corresponding to the type of sort you want (e.g., click 
"Author" in the Message List pane to sort by author).    Note:    To sort by thread when viewing one of the 
other sorts, click on the "Status" column.    You can change order (ascending or descending) of the date, 
size, and author sorts with the Display tab of the Preferences dialog box (you must resort the Message 
List pane for these changes to take effect).

You can now receive email from POP3 and SMTP servers.    To configure Agent for email, choose 
Inbound Email from the Options menu and fill in the System Profile tab.    To check for new mail, choose 
Check for Email from the Online menu.    To import your old mail from Eudora or Pegasus, search for 
"Importing messages" in this help file.

Added additional Introduction Strings strings for replying from an email.



Added a progress indicator when downloading message bodies.    Among other things, you can now tell 
how much progress you're making on each part of a binary download.

Added support for "poster" in the follow-up field.      Here's how it works:
· When posting a Usenet article, if you wish to have follow-up messages sent to you via email, set the 

Followup-To field to "poster".
· If you followup to a message with "poster" in the Followup-To field, Agent now creates an email 

message composition window rather than a news article composition window.

Modified the right mouse button behavior to work like Windows 95, which also allows you to select items 
from the context menus with either the right or left buttons.    To revert to the old behavior, edit the 
following line in AGENT.INI:

[Browser]
RightButtonSelects=0

Added protection against automatically launching executable binary attachments.    For details, see the 
Confirmations tab of the Preferences dialog box.

You can now choose which fields appear at the top of message bodies.    See AGENT.INI for details.

Added Ctrl+H as a keyboard accelerator to toggle "Show All Header Fields."

Added the "Organization" field to the list of fields you can set in email messages.

Fixed bug which could cause Agent to hang on some servers when it tried to retrieve an article that was 
no longer available.




